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INTRODUCTION 

Paragon Hard Disk Manager™ 2009 Server is an integrated set of powerful tools that is specially designed to 
tackle most of the problems you might face while using PC. Its functionality covers all aspects of a computer 
life cycle beginning from carrying out all the necessary partitioning operations to install the system from 
scratch and providing its data reliable protection to secure utilization of an outdated hard disk. 

In this manual you will find the answers to many of the technical questions, which might arise while using the 
program. 

WHAT’S NEW IN HARD DISK MANAGER 2009 

� Support of the File backup. You can now back up only information you really need, thus saving time 
and the backup storage space. Besides by making incremental images to this kind of backup you can 
easily keep it updated. 

� File backup to a sector image. It is a unique technology on the market so far that bridges two 
principally different approaches of the data backup: the file-based backup and the sector-based 
backup. With its help you can now create a sector-based backup of your system to get it back on 
track in minutes in case of a virus attack or a hardware malfunction and then just make file-based 
incremental images to the previously created sector-based backup to keep updated only information 
that is critical for you. Thus you will considerably save your system resources. 

� Adaptive Restore. It is a special technology that enables to successfully recover Windows Vista or 2008 
Server to a different hardware configuration. If you need to replace failed hardware and cannot find 
an exact match for your original system specifications, this feature will help you out. Besides you can 
even restore a backup image of your real system to a virtual one and vice versa. 

� Support of the Windows Installer MSI package. It is the latest engine for the installation, maintenance 
and removal of software on Windows-based operating systems. With its help you can now install the 
product remotely or in the silent mode, make use of powerful deployment capabilities, etc. 

� Improved 64-bit support. You don’t need to reboot your computer from the Recovery CD every time 
an operation cannot be accomplished under 64-bit Windows any more. The program will 
automatically reboot to a special mode to complete the operation. 

� Support of GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme 
developed to lift restrictions of the old MBR. GPT disks are now supported by Windows Vista, Server 
2008, Mac OS X and Linux. 

� Support of the latest Linux kernel. It offers support of a wider range of hardware configurations, 
including the brand new Intel ICH9 chipset. 

� Integration of the Linux/DOS recovery media directly to the installation package. You can now burn it 
with the Recovery Media Builder any time you want. Besides it will also be used as a bootable part of 
any bootable backup image created with the program. 

� Linux/DOS recovery environment on a USB flash drive. With the help of the Recovery Media Builder you 
can now create Linux/DOS bootable media on a USB flash drive that may later be used for 
maintenance or recovery purposes. 
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� Dual boot Backup Capsule. Now you’ve got the choice to launch the Linux or PTS DOS recovery 
environment every time you start up the computer. With its help you will be able to run utilities under 
Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. 

� Support of the Apple Boot Camp Configuration. With the Boot Camp utility Apple Inc. offers a 
technology to set up a dual boot system (Mac OS X and Windows XP/Vista) on Intel-based Macs. With 
the Linux/DOS recovery environment you can now easily backup/restore this kind of configurations. 

� A context sensitive hint system for all functions of the program. You can now get a detailed description 
to any setting, control, or field of the program just by clicking the hint button and then the object you 
need. 

� Automatic data exclusion. An advanced system of filters will help you automate the process of building 
up contents of the future backup image, by excluding irrelevant data such as movies, music, etc. 

� Support of Blu-ray discs. You can now burn backup images to high capacity Blu-ray discs. A single layer 
Blu-ray can store 25 GB, more than five times the capacity of a single layer DVD. 

PRODUCT COMPONENTS 

In order to cope with different tasks, the product contains several components: 

� Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher 
you may find and run tasks of any complexity in the field of data and system protection, hard disk 
partitioning and cloning, etc. 

� Linux/DOS based Recovery CD is a multi-platform bootable media that enables to run utilities under 
Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. 
Both platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or 
USB devices. It enables to burn CD/DVD disks. However there can be some difficulties with detecting 
new hardware. DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS 
Recovery CD requires no installation and can be of great help when the system fails to boot. Besides it 
offers a Windows XP like environment. 

� WinPE based Recovery CD. Especially for keen followers of Windows, our product also offers a WinPE 
based bootable media. Unlike Linux/DOS Recovery CD it can boast an excellent hardware support 
and the same interface as for the Windows version. However its system requirements are much 
tougher. 

FEATURES OVERVIEW 

This chapter dwells upon key benefits and technical highlights of the product. 

KEY FEATURES  

Let us list some of the key features: 

USER FRIENDLY FAULT MINIMIZING INTERFACE 

� Graphical representation of the data to gain a better understanding. 

� A handy launcher to easily find and run the required tasks. 
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� Comprehensive wizards to simplify even the most complex operations. 

� A context sensitive hint system for all functions of the program.  

� Previewing the resulting layout of hard disks before actually executing operations (so-called virtual 
operations). 

BACKUP FACILITIES 

� Archive Database to help the user easily manage backup images (get properties, add, delete, mount, 
etc.). 

 
This feature is only available for the Windows installation of the program.� 

� Support of all present day techniques to store backup images: 

- Backup to local mounted/unmounted (without drive letter assigned) partitions; 

- Backup to a special secured place on the hard disk called the Backup Capsule that has an 
independent system layout (e.g. a separate partition) and will stay operable should the active file 
system be damaged. To avoid an accidental removing or unauthorized access of the backup data, 
this partition is hidden and thus cannot be mounted in the operating system; 

- Backup to external media (CD/DVD) to guarantee a high level of data protection as long as the 
backup media is kept secure; 

- Backup to a network drive to stand a better chance of success in case of a hard disk failure. 

� Sector backup to save not only all on-disk information but also the system service structures. It is ideal 
for making a backup image of an entire hard disk or system partitions to guarantee the operating 
system’s working capability. 

� Differential backup to a sector image to only archive changes since the last full sector-based image, 
thus considerably saving the backup storage space. To restore this kind of backup you will require a full 
image and one of its differentials. 

� File backup to save information you really need. If you only care about safety of your e-mail database 
or particular documents and are not willing to waste the backup storage space, this very feature will 
suit you at most. Besides an advanced system of filters will help you automate the process of building 
up contents of the future backup image. 

� Incremental backup to a file image to only archive changes since the last full or incremental file-based 
image. An incremental image is smaller and takes less time to create, but you will require the initial full 
image and all of its incrementals to restore the latest point of this kind of backup. 

� File backup to a sector image. It is a unique technology on the market so far that bridges two 
principally different approaches of the data backup: the file-based backup and the disk imaging 
backup. With its help you can now create a sector-based backup of your system to get it back on 
track in minutes in case of a virus attack or a hardware malfunction and then just make file-based 
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incremental images to the previously created sector-based backup to keep updated only information 
that is critical for you. Thus you will considerably save your system resources. 

� Cyclic backup to automate the backup of separate partitions. It is an ideal option if you want to 
establish a self-acting data protection system. 

 
Cyclic Backup is only available for the Windows installation of the program.� 

� Synthetic backup to change any property (merge a given differential image with its full image, split/un-
split, compress/de-compress, etc.) of an existing backup image without carrying out a physical backup 
operation. 

� Bootable Backup Capsule to get the choice to launch the Linux or PTS DOS recovery environment 
every time you start up the computer. With its help you will be able to run utilities under Linux or PTS 
DOS, and that way to get access to your hard disk for maintenance or recovery purposes. 

 
This feature is only available for the Windows installation of the program.� 

RESTORE FACILITIES 

� Restore an entire disk, separate partitions or only files you need from the previously created backup 
image. 

� Restore with Shrink to restore a backup image to a free block of smaller size taking into account only 
the amount of actual data of the image. 

� Adaptive Restore to successfully recover Windows Vista or 2008 Server to a different hardware 
configuration. If you need to replace failed hardware and cannot find an exact match for your original 
system specifications, this feature will help you out. Besides you can even restore a backup image of 
your real system to a virtual one and vice versa. 

COPY FACILITIES 

� One Button Copy Wizard to carry out such a technically complicated operation as cloning of hard disks 
just by pressing one button. 

� Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap 
code and other system service structures, thus maintaining the operating system’s working capability. 

 
Copy functionality can also be used as an alternative way of data protection. 

BOOT MANAGEMENT FACILITIES 
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� Boot Manager Setup Wizard to easily manage several operating systems on one computer. 

PARTITION/HARD DISK MANAGEMENT FACILITIES 

� Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of 
the standard Windows disk tools, the program supports all popular file systems. 

� Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent 
partitions (NTFS, FAT16/FAT32), into a single, larger partition. 

� Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk 
unallocated space and the unused space of other partitions. 

� NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and 
interrupting its work. 

� Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting. 

� Mount a partition (assign a drive letter) of any file system type to make it available for your operating 
system. 

� Modify file system parameters (make active/inactive, hide/unhide, change serial number, partition ID, 
volume label, etc.). 

� Install New OS Wizard to make your system ready to install a new operating system. 

� Undelete Partitions Wizard to recover an accidentally deleted partition. 

FILE SYSTEM OPTIMIZATION FACILITIES 

� 27 defragmentation strategies available to defragment FAT and NTFS file systems. 

� MFT defragmentation and shrinking to improve performance of NTFS. 

� Low free space defragmentation (less than 1% of the free space required) to successfully defragment 
almost full disks. 

 

Defragmentation is accomplished with a separate component called Paragon Total 
Defrag. To know more on the subject, please consult its help. 

WIPE FACILITIES 

� Data wiping to successfully destroy all on-disk information including the standard bootstrap code and 
other system service structures. 

� Free space clearing to destroy any remnants of deleted files/directories left on disk without affecting 
the used data. 

AUTOMATIZATION FACILITIES 
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� Task scheduling to automate routine operations. It can be particularly effective when you have to 
repeat a sequence of actions on a regular basis. 

 
Scheduling is only available for the Windows installation of the program. 

� Scripting to make the program create a script of any set of operations you need. Besides support of all 
operations available in the interactive mode, the unattended mode provides some additional 
features, such as conditional execution, subroutines, repeatable iterations, disk/partition properties 
analysis, errors management, etc. 

AUXILIARY FACILITIES 

� File Transfer Wizard to make such operations as transferring of files/directories or burning of them to 
CD/DVD as easy and convenient as possible. Providing access to Paragon backups as regular folders, 
it may also help to replace corrupted data from a previously created image in case of an operating 
system failure. 

� Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain 
an operating system or just data. Volume Explorer will let you explore a file system of any type and 
provide access to the necessary files and directories regardless of their security attributes. 

� Recovery Media Builder to create a Linux/DOS bootable media, which can later be used to boot and 
recover your computer in case of an operating system failure. Moreover, with its help you can save 
data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility supports 
various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray 
and can handle multi-session burning. 

� Network Configuration Wizard to establish a network connection under Linux either to save a backup of 
a partition/hard disk or just several files on a network computer or retrieve a previously made backup 
from a network computer for recovery purposes. 

SUPPORTED TECHNOLOGIES 

Along with using innovative technologies from outside, Paragon has developed a number of its own original 
technologies that make its products unique and attractive for customers: 

� Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ 
family operating systems providing both high operating efficiency as well as low hardware 
requirements. 

� Paragon Adaptive Restore™ technology to successfully recover Windows Vista or 2008 Server to a 
different hardware configuration. 

� Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, 
power outages or an operating system failure. 

� Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, 
modify and copy files and folders, etc. 
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� Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting 
Windows and interrupting its work. 

� Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller size 
taking into account only the amount of actual data of the image. 

� Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any 
complexity. 

� Paragon BTE™ technology to set tasks for execution in the Windows blue screen mode, thus saving from 
the need to use a bootable media when modifying system partitions. 

� Paragon Shutdown After Apply™ technology to set the computer to automatically switch off on the 
successful accomplishment of any operation. 

� Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management 
flexibility without the partition limitation of basic disks. Dynamic storage can be particularly beneficial 
for large-scale businesses when dealing with many physical hard disks involving complex setup. 

SUPPORTED FILE SYSTEMS 

Paragon Hard Disk Manager 2009 provides support of major file systems presented on the market today: 

� Full read/write access to FAT16/FAT32 partitions. 

� Full read/write access to NTFS (Basic and all five types of Dynamic Disks) under Windows 95/98/ME, 
Linux and PTS DOS. Compressed NTFS files are also supported. 

� Full read/write access to Ext2FS/Ext3FS partitions under all versions of Windows, DOS 5.0 and later. 

� Basic partitioning operations (create, format, delete) for Linux Swap. 

� Limited read/write access to Apple HFS+ partitions. 

 

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable 
at the moment. The company is about to implement it in the nearest future. 

SUPPORTED MEDIA 

� Support of both MBR and GPT hard disks (up to 1,5 TB tested) 

� IDE, SCSI and SATA hard disks 

� CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs 

� FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks, ZIP® and Jazz® disks 

� PC card storage devices (MBR and GPT flash memory, etc.) 

GETTING STARTED 

In this chapter you will find all the information necessary to get the product ready to use. 
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DISTRIBUTION 

Paragon Hard Disk Manager 2009 is distributed in two ways: 

� Boxed package from Paragon Technology GmbH and resellers 

� Downloadable package over the Internet at the company’s web-site 

DISTRIBUTIVE CD 

The boxed package includes a distributive CD that is in fact a bootable Linux/DOS Recovery CD with auto-run 
of the Windows installation, thus it can be used as a ready-made solution (see Booting from the Linux/DOS 
Recovery CD). But if you’re going to run the Windows components, you need to install them first (see Installing 
the Program under Windows). 

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation 
package as described in Online Distribution). 

 

The WinPE version can only be obtained through the company’s web service. You will 
get the required download link after the product has been purchased. 

ONLINE DISTRIBUTION 

Hard Disk Manager 2009 purchased over the Internet will be in form of an MSI package. After installing the 
product you can launch the Recovery Media Builder to burn the Linux/DOS Recovery CD. 

 

The WinPE version can only be obtained through the company’s web service. You will 
get the required download link after the product has been purchased. 

 
REGISTRATION 

Paragon Technology GmbH provides a wide range of online services through its web-service - KB (Knowledge 
Base): 

� Registration of new users; 

� Registration of purchased products for registered users; 

� Available around-the-clock downloading center, where registered users can get product 
updates/upgrades as well as all the necessary documentation; 

� Downloadable free demo versions and open documentation for all users. 

To enter the Knowledge Base, please visit the web-site: http://kb.paragon-software.com/. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 

http://kb.paragon-software.com/


 

 
It is recommended to use Internet Explorer 5+ or any compatible browser. 

TO REGISTER AS A NEW USER 

To register as a new user, simply do the following: 

1. Run the Internet browser and visit the page: http://kb.paragon-software.com/; 

2. Select Registration in the menu; 

3. On the renewed page, select your country and language; 

4. Fill out the registration form. 

The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your 
access password will be sent to this address as well. 

TO REGISTER A NEW PRODUCT 

If you are a registered user and would like to register Hard Disk Manager 2009, simply do the following: 

1. Click Login in the menu; 

2. On the Login page, in the User Name field, enter an E-mail, which you have used for registration;  

3. In the Password field enter the password you received with registration confirmation. Click the Submit 
button; 

4. If the user name and password are valid, you will enter the system; 

5. In the opened menu click the Product Registration item to see a list of all registered products with a 
new registration form; 

6. Select Paragon Hard Disk Manager 2009 from the list of products; 

7. Type in your product serial number in the Serial Number field. Click the Submit button. 

That is all. You will receive a confirmation by E-mail. 

HOW TO DOWNLOAD UPDATES/UPGRADES 

Downloading of updates/upgrades can be fulfilled in the following way: 

1. Enter the Paragon Software web-service; 

2. In the menu click the Download Update to see what updates are available for you; 

3. Select the desired update and click the Download button. 

CONTACTING PARAGON TECHNOLOGY GMBH 
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If you have any questions about the company products, please do not hesitate to contact Paragon 
Technology GmbH. 

Service Contact 

Visit Paragon GmbH web site www.paragon-
software.com 

Registration & updates web-service kb.paragon-software.com 

Knowledge Base & Technical Support kb.paragon-software.com 

Pre-sale information sales@paragon-
software.com 

SYSTEM REQUIREMENTS 

WINDOWS BASED SET OF UTILITIES 

To use the Windows utilities, you should install them first. But before that, make sure your computer meets the 
following minimum system requirements: 

� Operating systems: Windows 2000/XP/Vista/Server 2000/2003/2008 and XP SP2/Vista/Server2003/2008 
64-bit 

� Internet Explorer 5.0 or higher  

� Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

� 128 MB of RAM 

� Hard disk drive with 100 MB of available space  

� SVGA video adapter and monitor  

� Mouse 

LINUX/DOS BASED RECOVERY CD 

To use the Paragon Linux/DOS Recovery CD on your computer (it doesn’t matter what operating system is 
installed), make sure that it meets the following minimum system requirements: 

� IBM AT compatible computer with i486 or higher CPU 

� 256 MB of RAM  

� SVGA-compatible monitor 

� Mouse (recommended) 
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� On-board BIOS supports booting from CD first 

There may be additional requirements if you want to use advanced features: 

� Network card is required to send partition/hard disk backups to a network computer or to retrieve 
previously made backups 

� Recordable CD/DVD drive is needed to burn data to compact disks 

� To save copy or backup of a hard disk or partition, removable USB disks can be used. The program 
supports USB Drives 1.0, 2.0.  

WINPE BASED RECOVERY CD 

To use the WinPE based Recovery CD on your computer, (it doesn’t matter what operating system is installed), 
make sure that it meets the following minimum system requirements: 

� Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

� At least 384 MB of RAM (512+ is recommended) 

� SVGA video adapter and monitor 

� Mouse 

INSTALLING THE PROGRAM UNDER WINDOWS 

As we have already mentioned only Windows components of the product require installation. So to install 
Paragon Hard Disk Manager 2009 under Windows, please do the following: 

1. Run Setup Application. Click on the DriveBackup.MSI file. This application will guide you through the 
process of the program installation. The setup utility is compiled with the InstallShield SDK, hence it 
contains the standard user interface and set of installation steps. 

 

In case there is some previous version of the program installed on the computer, the 
program will offer the user to uninstall it first. 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button 
to continue. 

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. 
Read the agreement and then select the appropriate option to accept. If you do not agree with any 
conditions stated there, the installation process will be interrupted. By clicking the Print button, the 
License Agreement may also be printed out. 

4. Provide Customer Information. On the Customer Information page you are to provide the standard 
information, i.e. a user name and an organization. Besides you need to decide whether to make the 
program available for all users of this computer (if several) or only for the current one. 

5. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the 
program will be installed. By default, the installation folder will be created as: 
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C:\Program Files\Paragon Software\Paragon Hard Disk Manager 2009. To select another folder, click 
the Change… button. 

After you have selected the required folder, click the Next button to continue. 

 

Do not install the program on network drives. Do not use Terminal Server sessions to 
install and run the program. In both cases, the program functionality will be limited. 

6. Confirm Installation. On the Ready to Install the Program page click the Install button to start the 
installation or the Back button to return to any of the previous pages and modify the installation 
settings. 

7. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel 
button to abort the setup. 

8. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to 
complete the wizard. 

 

To accomplish online backup/copy of locked partitions/hard disks the program uses a 
kernel mode hotcore driver, thus the system reboot is required to complete the 
installation procedure. 

STARTING THE PROGRAM UNDER WINDOWS 

To start Paragon Hard Disk Manager 2009 under Windows, please click the Windows Start button and then 
select Programs > Paragon Software > Paragon Software Hard Disk Manager™. 

 

The program provides wide opportunities in the field of hard disk structure 
modification, so just to be on the safe side, please make a backup of your data before 
carrying out any operation. 

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out 
categorization and hint system, it provides quick and easy access to wizards and utilities that we consider 
worth using on a regular basis. With its help you can also start up the traditional launcher, the help system or go 
to the program’s home page. 
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To start up the traditional launcher, first go to the Advanced Options and then choose 
HDM 2009 Server. To know more on the subject, please consult the Windows 
Components chapter. 

BOOTING FROM THE LINUX/DOS RECOVERY CD 

The Linux/DOS Recovery CD can be used to boot your computer into Linux or PTS DOS to get access to your 
hard disk for maintenance or recovery purposes. On the disk you can also find the PTS DOS safe mode, which 
may help in a number of non-standard situations such as interfering hardware settings or serious problems on 
the hardware level. In this case, only basic files and drivers (such as hard disk drivers, a monitor driver, and a 
keyboard driver) will be loaded. 

STARTUP PROCEDURE 

To start working with the Linux/DOS Recovery CD, please take the following steps:  

1. Insert the Linux/DOS Recovery CD into a CD/DVD drive; 

2. Reboot the computer; 

3. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu. 

 

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

4. Click on the required operation to start. Hints on the selected at the moment item will help you make 
the right choice; 
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5. Consult the help system by pressing ALT+F1 to know more on the subject. 

 

To automatically boot from the Recovery CD make sure the on-board BIOS is set up to 
boot from CD first. 

BOOT MENU 

After you have inserted the Recovery CD into a CD/DVD drive and restarted the computer, the Boot menu 
appears. 

 

The Boot menu contains the following commands: 

� Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended). 

� Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal 
mode if it fails to work properly. 

� Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers 
will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a 
simple menu. 

� Floppy Disk. Reboot the computer from a system floppy disk. 

� Hard Disk 0. Boot from the primary hard disk. 

� Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable 
operating system. 

To move within the menu, please use the arrow keys of the computer keyboard. 

 

To automatically boot from the Recovery CD make sure the on-board BIOS is set up to 
boot from CD first. 

While working with the Recovery CD you might experience some inconvenience 
caused by possible video artifacts. It is just a result of changing video modes and in no 
way will affect the program functionality. If this is the case, please wait a bit and 
everything will be OK. 

NORMAL MODE 
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When the Normal mode is selected, the Linux launch menu appears: 

� Hard Disk Manager (enables to copy and back up separate partitions or entire hard disks, carry out 
partitioning operations, etc.); 

� Simple Restore Wizard (allows restoring hard disks and partitions); 

� One Button Copy Wizard (helps to carry out such a technically complicated operation as cloning of 
hard disks just by pressing one button); 

� Wipe Wizard (enables to destroy all on-disk information or only remnants of deleted files/directories); 

� File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to 
CD/DVD); 

� Boot Corrector (helps to correct the Windows System Registry without Windows being loaded); 

� Network Configurator (enables to establish a network connection under Linux); 

 

If you are going to use network resources, first launch the Network Configuration 
Wizard to establish a network connection. 

� Log Saver (helps to collect and send the necessary log files to the Technical Support); 

� Command Line (allows experienced users to execute any operation); 

� Reboot the computer; 

� Power off the computer. 

To move within the menu, please use the arrow keys of the computer keyboard. 

SAFE MODE 
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When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for 
the Normal mode except the Network Configurator and Log Saver commands. Besides due to certain 
limitations of the PTS DOS environment, there is no possibility to burn CD/DVD disks. 

LOW GRAPHICS SAFE MODE 

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality 
and looks similar to the Safe mode but graphically simpler. 

BOOTING FROM THE WINPE RECOVERY CD 

The WinPE Recovery CD can be a real alternative to the Linux/DOS Recovery CD. Providing nearly the same 
level of functionality it offers an excellent hardware support and the same interface as for the Windows 
version. 

STARTUP PROCEDURE 

To start working with the WinPE Recovery CD, please take the following steps: 

1. Insert the WinPE Recovery CD into a CD/DVD drive; 

2. Reboot the computer; 

3. After the disc has been loaded, you will see the License Agreement. Read the agreement and then 
mark the appropriate checkbox to accept. If you do not agree with any conditions stated there, you 
won’t be able to use the program; 
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�  

To automatically boot from the Recovery CD make sure the on-board BIOS is set up to 
boot from CD first. 

4. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables 
to run components of the product, load drivers for undefined hardware or establish a network 
connection. 

 

5. Click on the required operation to start. Hints on the selected at the moment item will help you make 
the right choice; 
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6. Consult the help system by pressing ALT+F1 to know more on the subject. 

BASIC CONCEPTS  

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain 
a general notion of the operation performance and makes it easier for the user to operate the program. 

SYSTEM AND DATA PROTECTION  

The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly 
to find a person who will be particularly happy when all precious information on the hard disk is irreversible lost 
as a result of its malfunction. So how this tragedy can be prevented? 

FILE BACKUP VERSUS SECTOR BACKUP 

Since the advent of the computer age people were in the search of ways to guarantee data safety. As a 
result we’ve got now two principal approaches: the file-based backup and the sector-based backup. The 
main difference between the two lies in the way data is treated. 

A sector-based backup operates with an image (or a snapshot) of the whole disk system or its separate 
partitions. It not only includes the contents of all user-made files, but additionally contains the exact structure 
of directories, information about file allocation, file attributes and other related data. Thus it enables to 
successfully process system or encrypted partitions of any file system type, no matter what kind of information 
they contain. 

In contrast, a file-based backup takes into account a file system structure and only functions on a file or folder 
level. So it is very efficient when archiving separate files or folders, but in no way will help you back up a system 
partition. 

You should understand pretty well that each of the two approaches is only good when properly chosen. In the 
comparison table below you can see when this or that approach will suit you at most. 

Sector-Based Backup File-Based Backup 

Merits 

It does not dependent on a particular file 
system. Thus it can successfully process 
system or encrypted partitions of any file 
system type, no matter what kind of 
information they contain. 

Functioning on a file/folder level, it is ideal for 
archiving separate files or folders. 

It can create an exact image of a partition, 
including its service data. Thus it is ideal for a 
backup/restore of a system partition or a fast 
deployment to a bunch of identical 
computers. 

It enables to automatically build up contents 
of the future backup image by using an 
advanced system of filters. 
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 It allows archiving data of the same volume 
with different backup policies. 

 It is easy and efficient when creating backup 
chains. 

Demerits 

Resulted backup images may contain a lot of 
redundant data. 

It depends on a file system structure, so you 
won’t be able to process unknown file 
systems. 

It is ineffective when trying to maintain a 
backup chain, especially when little amount 
of data is being changed. 

It cannot be used to back up a system 
partition. 

 It is much slower when processing large 
amount of data. 

BACKUP TYPES 

At the present moment the market is offering various types of backup imaging to meet the needs of any user. 
Besides supporting them all, our program offers a unique backup type, called File Increment to a Sector 
Backup. 

FULL AND DIFFERENTIAL SECTOR BACKUPS 

A full sector-based backup image includes all contents of a partition or a hard disk at the moment of its 
creation. If you roll back your system to the initial state on a regular basis, that’s exactly what you’re looking 
for. But if you want to have multiple backup archives of the same partition reflecting certain time stamps, 
unchanged data will inevitable be duplicated in all archives and take additional space on backup media. To 
tackle this issue there has been developed a supplementary technique called Differential Sector Backup. 

A differential archive only contains data changed since the time of creating a full archive, which forms a base 
(or a parental image) in this case, thus considerably saving your system resources. It is realized by the exact bit-
wise comparison of the previous partition's data (saved in the parental image) with the current data (that is 
actually the partition itself). To restore this kind of backup you will require a full image and one of its 
differentials, what is very convenient. 
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�  
This function is only available for single primary and logical partitions. 

FULL AND INCREMENTAL FILE BACKUPS 

A full file-based archive only contains files and folders. It is really efficient when backing up an e-mail database 
or particular documents, as no redundant data is processed. But if you care about maintaining a files history, 
you can benefit from one more supplementary technique called Incremental File Backup. 

An incremental archive only contains data changed since the time of creating a full or incremental file-based 
archive. It is smaller and takes less time to create, but you will require the initial full image and all of its 
increments to restore the latest point of this kind of backup. 

 

FILE INCREMENT TO A SECTOR BACKUP 

File Increment to a Sector Backup is a unique technology on the market so far that bridges two principally 
different approaches of the data backup: the file-based backup and the sector-based backup. With its help 
you can now create a sector-based backup of your system to get it back on track in minutes in case of a virus 
attack or a hardware malfunction and then just make file-based incremental images to the previously created 
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sector-based backup to keep updated only information that is critical for you. Thus you will considerably save 
your system resources. 

BACKUP STORAGE 

Our program supports all present day techniques of storing backup images. Let’s take a closer look at them all 
to understand what kind of storage is able to provide better security: 

� You can place a backup image to a local mounted or unmounted (without drive letter assigned) 
partition. Despite the fact that it is the most convenient way, try not to use it. You can delete your 
backup just by accident or lose it as a result of a hardware malfunction, or a virus attack; 

� You can place a backup image to a special secured place on the hard disk called the Backup 
Capsule that has an independent system layout (e.g. a separate partition) and will stay operable 
should the active file system be damaged. To avoid an accidental removing or unauthorized access of 
the backup data, this partition is hidden and thus cannot be mounted in the operating system. 
However it won’t help you in case of a hardware malfunction; 

� You can place a backup image to external media (CD/DVD) to guarantee a high level of data 
protection as long as the backup media is kept secure; 

� Finally you can place a backup image to a network drive to stand a better chance of success in case 
of a hard disk failure. Moreover, by storing it on a special-purpose server you may be pretty sure 
nothing will happen to it. 

ADAPTIVE RESTORE 

Adaptive Restore is a special technology that enables to successfully recover Windows Vista or 2008 Server to 
a different hardware configuration. It is based on the fact that these operating systems do not delete their 
distributive driver repositories after the setup, but simply make them inactive in the Windows Registry. So thanks 
to our technology these driver repositories can be made available during the restore procedure to let 
Windows Vista or 2008 Server automatically find and install any lacking driver with no action from your side 
required, what is very convenient. 

However you might face a situation when no driver has been found in the driver repository. So in this case you 
will have to provide an exact location of the required drivers or insert the Windows distributive CD/DVD, 
besides it is expected extra system restarts. Anyway your system will most likely be operable once again. 

Let’s consider a number of situations when the Adaptive Restore feature can help you out:  

� If you need to upgrade to newer hardware while keeping all your programs and settings intact; 

� If you need to replace failed hardware and cannot find an exact match for your original system 
specifications; 

� If you need to do a system testing to deploy a system backup image to a virtual machine or vice versa. 

�  

This feature is only available for the Linux/DOS or WinPE recovery media at the 
moment. 
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PARAGON HOT PROCESSING & VOLUME SHADOW COPY SERVICE 

OFFLINE VERSUS ONLINE DATA PROCESSING 

In the course of time there have been developed various methods of data processing. Despite different work 
concept, all of them can be divided into two principal groups: offline (cold) and online (hot) data processing 
techniques. 

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the 
operating system and all the applications are completely shut down). Actually it is the most preferable way of 
image creation or data cloning, since software can obtain an exclusive right to process data that guaranties 
high level of operating efficiency. However, the offline data processing is absolutely out of question when 
dealing with 24/7 production environments. 

In contrast, online data processing enables to create a consistent snapshot even as the data is currently 
modified. It is particularly useful for systems with high availability requirements, but it won’t be accomplished 
until all active transactions are complete. The point is to provide a coherent state of all open files and 
databases involved in a process, taking into account that applications may still keep writing to disks. As a result 
an online data processing cannot boast high operating speed. 

Our program supports both offline and online methods of data processing. As far as online method is 
concerned it offers its own hot processing algorithm together with the possibility to use snapshot technologies 
provided by the Microsoft VSS framework. 

PARAGON HOT PROCESSING TECHNOLOGY 

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. 
Developed back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company. 

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an 
online copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk 
write activity of applications and the operating system. The hotcore driver as an integral part of the program is 
installed during the setup procedure (that’s why the system reboot is required to complete the setup 
procedure). For the most part the driver is in the idle mode until it is activated with the program. While in this 
mode it bypasses any calls having no effect on the overall system performance, but a few kilobytes of the 
system memory. 

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows 
NT+ family operating systems providing both high operating efficiency as well as low hardware requirements. 

�  

It is not recommended to use Paragon Hot Processing with active SQL Server, 
Exchange or Oracle databases since the backup image contents may be corrupted. 

VOLUME SHADOW COPY SERVICE 

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the 
Microsoft Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create 
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consistent point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation 
with the leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.  

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents 
them as virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the 
copy/backup utility starts processing the data while applications keep writing to original volumes. 

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous 
snapshot of multiple volumes. This very feature can be particularly beneficial when backing up active SQL 
Server 2003, Exchange 2003 or Oracle databases located on multiple volumes the way it is recommended by 
Microsoft to improve the level of database performance and reliability, thus providing 100-percent data 
consistency. 

�  
To use VSS it is necessary to have a mounted 300 MB+ NTFS partition. 

DYNAMIC DISKS 

As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four 
primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to 
create logical drives within the extended partition. Such types of disks are called basic. Windows XP Server, 
Windows 2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a 
maximum of four primary partitions, one of which can be an extended partition with logical drives. However, 
these operating systems also introduce a new disk configuration type - dynamic disk - which must be 
understood to effectively configure and manage hard disks. 

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic 
volumes. Regardless of what format you use for the file system, only Win2K computers can access dynamic 
volumes directly. However, computers that aren't running Win2K can access the dynamic volumes remotely 
when connected to the shared folders over the network. 

Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and 
Dynamic disks on the same hard drive. 

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from 
free disk space that is linked together from multiple disks), striped (a volume the data of which is interleaved 
across two or more physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two 
physical disks, and RAID-5 volumes (a fault-tolerant volume the data of which is striped across an array of three 
or more disks). 

With dynamic storage, you can perform disk and volume management without the need to restart Windows. 

Limitations: 

� Dynamic disks are not supported on portable computers. 

� Dynamic disks are not supported on Windows XP Home Edition-based computers. 

� You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows XP 
Server, or Windows XP 64-Bit Edition-based computers. 
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Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more 
management flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited 
number of volumes, but they cannot contain partitions or logical drives. Dynamic storage can be particularly 
beneficial for large-scale businesses when dealing with many physical hard disks involving complex setup. 

GPT VERSUS MBR 

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift 
restrictions of the old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to 
replace the outdated PC BIOS, it offers a number of crucial benefits: 

� Up to 128 primary partitions for the Windows implementation (only 4 in MBR); 

� The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR); 

� More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition 
table; 

� A well defined and fully self-identifying partition format (data critical to the platform operation is 
located in partitions, but not in un-partitioned or hidden sectors as this is the case with MBR). 

Please note, that the current version of the product provides a limited support of GPT disks: 

� Paragon Hot Processing is not available; 

� You cannot clone a GPT hard disk; 

� You cannot create the backup capsule on a GPT disk. 

Besides, you won’t be able to see a drive letter assigned to a GPT disk in the program’s interface. 

APPLE BOOT CAMP 

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) 
on Intel-based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create 
a separate partition for Windows) and then launch the installation process. With Boot Camp all the necessary 
drivers will be at your disposal. Moreover after Windows has been installed it will serve as a boot manager to 
choose what operating system to start up. 

Our program provides the ability to successfully backup/restore this kind of configurations with the Linux/DOS 
recovery environment. 

64-BIT SUPPORT 

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end 
user. However that is not the case when dealing with servers processing large amounts of data with complex 
calculations of very large numbers. That is where 64-bit architecture comes into play.  

It can boast improved scalability for business applications that enables to support more customer databases 
and more simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such 
as memory allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than 
a 32-bit processor. With these resources, even a very large database can be cached in memory.  
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Although many business applications run without problems on 32-bit systems, others have grown so complex 
that they use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer 
memory resources are available to meet memory needs. On a 64-bit server, most queries are able to perform 
in the buffers available to the database. 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, 
system-level utilities and programs that provide direct hardware access are likely to fail. Our program offers a 
full-fledged support of the 64-bit architecture providing fault-tolerant work for such system dependent modules 
as Hot Processing. 

COPY OPERATIONS 

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite 
advantages it can offer. First of all, many people clone hard disks just to back up data for security reasons. The 
present day copy utilities enable to successfully transfer all on-disk information including standard bootstrap 
code and other system service structures, thus maintaining the operating system’s working capability. In case 
of a system malfunction, the user can get the system back on track in minutes. No additional configuration is 
required, what is very convenient. 

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard 
drive doubles every two years, thus opening up new possibilities for software developers. As a result programs 
become more complicated and require considerable amount of free space. One day the user realizes that 
there is no more free space left on the hard disk and the only way out is to upgrade. Usually that means that 
besides purchasing a new hard disk, the user is to face a large re-installation procedure spanning several days 
of tedious work. But all of this can be avoided just by copying the contents of the old hard disk to a new one 
proportionally resizing the partitions. 

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting 
up similar computers. There is no need for a system administrator to install an operating system from scratch on 
every one of them. It is enough just to configure one and then clone it to the others. 

DRIVE PARTITIONING 

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is 
carved up and space is set aside for an operating system. Until recently most PCs used to have just one 
partition, which filled the entire hard disk and contained an OS. The situation has changed however, thanks to 
new cost-effective high capacity hard drives, thus opening up numerous possibilities for PC users, such as 
editing video, archiving music, backing up CD images, etc. Huge increase in space is great, but it poses a 
number of problems, most important of which are effective data organization and speed. 

Large drives are always going to take longer to search than smaller volumes, and an operating system is going 
to have its work cut out both finding and organizing files. It is for this reason that many people decide to invest 
in multiple hard drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single 
physical drive into a number of logical drives, each of which servers as a container with its own drive letter and 
volume label, thus enabling the operating system to process data more efficiently. Besides partitioning makes 
it possible to organize data so that it is easy to find and manage. You can set aside, for instance, 40 GB of a 
160 GB hard drive for the OS, 70 GB for storing video and another 50 GB for your favorite music collections to 
provide transparent data storage. 

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-
fragmentation or consistency check will not be that annoying and time-consuming any more. 
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By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system 
malfunction, you can get the system back on track in minutes by recovering it from a backup image located 
on the other partition of the hard drive. 

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing 
the Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order 
to run several OSs on a single hard drive you are to create a corresponding number of partitions to effectively 
delineate the boundaries of each OS. 

SCHEDULING  

The automation of operations is particularly effective when you have to repeat a sequence of actions on a 
regular basis. For example, developing a specific project on a day-to-day basis and having to make a backup 
every evening so as not to lose the valuable data, you will really appreciate, when this kind of routine 
operations will be carried out automatically without your participation. 

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is 
especially important when operations require a considerable amount of computer resources – processor time, 
memory and more. A number of tasks, which can decrease the performance, can be run during the night or 
whenever the computer has the least work-load to perform. 

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at 
a specified time without interrupting your current activity. 

DATA SANITIZATION 

Data security is a two-sided problem. It is to be made clear, that providing confidentiality implies not only 
information to be stored properly, but also be destroyed according to certain rules. The first step to protecting 
yourself is to know exactly which security precautions work and which do not. 

Many people believe the misconception that repartitioning a disk will result in complete destruction of its 
contents. Actually that is not quite so. Repartitioning the drive only alters references to partitions in the Partition 
Table, leaving all file data intact. In fact, there are a number of programs available to successfully recover 
previously deleted partitions. 

Formatting a drive also does not guarantee data destruction. Formatting procedure implies modification of 
the Master File Table (MFT) that keeps track of where file contents are stored on the disk and verification of 
each sector for consistency. Even a low-level format does not actually erase the file contents for good, since 
they can still be resurrected from their deleted state with minimal effort by using the popular today Magnetic 
Force Microscopy technology. 

The only way to make sure that all the data has been erased from a hard drive is to overwrite all on-disk 
sectors with random patterns of ones and zeros. Although this sounds complex, there is an easy way to do this. 

The process of deliberately, irreversibly removing or destroying the data stored on a memory device (magnetic 
disks, flash memory drives, etc.) is generally known as Data Sanitization. A device that has been sanitized has 
no usable residual data and even advanced forensic tools should not ever be able to recover it, thus 
providing maximum level of security. 

WINDOWS COMPONENTS 
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In the given section you can find all the information necessary to successfully work with the Windows version of 
the product. 

INTERFACE OVERVIEW 

This chapter introduces the graphical interface of the program. The design of the interface precludes any 
mistake being made on the part of the user. Most operations are performed through the system of wizards. 
Buttons and menus are accompanied by easy understandable icons. Nevertheless, any problems that might 
occur while managing the program can be tackled by reading this very chapter. 

GENERAL LAYOUT  

The main component of the program is called the Launcher. It enables to run wizards and dialogs, to specify 
program settings, to visualize the operating environment and the hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 
functionality: 
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1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map 

7. Partition List 

8. Properties Bar  

9. Legend Bar 
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10. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal 
some of them to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the 
screen layout. 

MAIN MENU  

The Main Menu provides access to the entire functionality of the program. The available functions are as listed 
below: 

MENU ITEM FUNCTIONALITY 

Tools 

Generate Script… Generate a script for the task 

Save to Scheduler… Schedule pending operations 

Send Log Files Compress and send the log to the Paragon Support Team 

View Logs… View logs on the carried out operations 

BM Setup Wizard… Manage several operating systems on one computer 

Recovery Media Builder… Restore the system even when the current operating system cannot boot 
anymore 

Check Recovery Disks… Verify the recovery media for integrity and ability to boot from 

File Transfer Wizard… Transfer data from any media 

Settings... Edit the general settings of the program  

Exit Exit the program 
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Changes 

Undo `the last virtual 
operation` 

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 
operation` 

Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info Refresh the current information about disks 

Wizards 

Create Partition… Create a partition of any file system 

Format Partition… Format a partition of any file system 

Delete Partition… Delete a partition of any file system 

Undelete Partitions… Recover an accidentally deleted partition 

Merge Partitions… Merge adjacent partitions of NTFS, FAT or FAT32 file systems 

Redistribute Free Space… Redistribute available disk space of existed partitions 

Install New OS… Make your system ready to install a new operating system 

Back up Disk or Partition… Create a sector-based archive of an entire hard disk or separate 
partitions 
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Restore Disk or Partition… Restore an entire hard disk or separate partitions from the backup image 

Schedule Backup… Set a timetable for a disk or partition backup 

Differential Backup… Create a differential to a partition backup 

Create File Complement… Create an increment to a full partition backup 

Backup Files… Create a file-based archive of your files and folders 

Restore Files… Restore files from the backup image 

Create a File Increment… Create an increment to a file backup 

Manage Backup Capsule… Create and manage the backup capsule 

Check Archive Integrity… Perform integrity check for the required backup image 

Cyclic Backup… Automate a partition backup 

One Button Copy Wizard Create a hard disk copy just by pressing one button 

Copy Hard Disk… Create a hard disk copy 

Schedule Hard Disk Copy… Set a timetable for a hard disk copy 

Copy Partition… Create a partition copy 

Schedule Partition Copy… Set a timetable for a partition copy 

Wipe Hard Disk or Partition... Destroy all on-disk information or only remnants of deleted 
files/directories 

Hard Disk 
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Back Up Hard Disk… Create a backup archive of the selected hard disk 

Burn Hard Disk to CD or 
DVD… 

Back up the selected hard disk and burn the resulted image to CD/DVD 

Restore Hard Disk… Restore the selected hard disk from a backup image 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Change Primary Slots… Modify the primary partitions enumeration for the selected hard disk 

Convert to Basic… Convert a dynamic disk containing simple volume(s) into basic 

Copy Hard Disk… Create a copy of the selected hard disk 

Wipe Hard Disk… Irreversibly destroy all on-disk information 

Edit/View Sectors… View/edit sectors of the selected hard disk 

Properties… Get in-depth information on the properties of selected hard disk 

Partition 

Create Partition… Create a partition 

Format Partition… Format a partition 

Delete Partition… Delete a partition 

Back Up Partition… Create a backup archive of the selected partition 

Burn Partition to CD or 
DVD… 

Back up the selected partition and burn the resulted image to CD/DVD 

Restore Partition… Restore the selected partition from a backup image 
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Move/Resize… Move/Resize the selected partition 

Convert File System… Convert file system of the selected partition 

Assign Drive Letter… Assign drive letter to the selected partition 

Remove Drive Letter… Remove drive letter for the selected partition 

Hide Partition… Make the selected partition unavailable for the operating system 

Unhide Partition… Make the selected partition available for the operating system 

Mark Partition as Active Make the selected partition bootable by default 

Mark Partition as Inactive Make the selected partition non-bootable by default 

Change Cluster Size… Change cluster size of the selected partition 

Change Boot Size… Change boot size of the selected partition 

Change Root Size… Change root size of the selected partition 

Change Volume Label… Change volume label of the selected partition 

Change Serial Number… Change serial number of the selected partition 

Change Partition ID… Change identifier of the selected partition 

Downgrade NTFS version… Decrease version of the selected NTFS partition 

Make Partition Primary… Make the selected partition Primary 

Make Partition Logical… Make the selected partition Logical 

Wipe Partition… Irreversibly destroy all on-partition information 
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Clear Free Space… Destroy any remnants of deleted files/directories left on disk 

Test Surface… Test surface of the selected partition/block of free space 

Check File System Integrity… Check the selected partition for possible file system errors 

Edit/View Sectors… View/edit sectors of the selected partition 

Properties… Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolbar Manage the Tool Bar representation: show / hide standard and 
navigation buttons, text labels and large icons 

Status Bar Display the Status Bar 

Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Disk Map Location Select whether the Disk Map will be located on the top of the main 
window or at the bottom 

Help 

Help Open the Help system (you can also do it by pressing F1) 

About Open the dialog with information about the program 
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�  

The Main Menu contents available at the moment may vary depending on the 
selected object. 

TOOL BAR  

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 
Back up a hard disk or partition 

 
Back up files 

 
Restore a disk or partition 

 
Restore files 

 
Copy a hard disk 

 
Copy a partition 

 
Open the Help system 

VIRTUAL OPERATIONS BAR  

The program supports previewing the resulting layout of hard disks before actually executing operations (so-
called virtual mode of execution). In fact, when the virtual mode is enabled, the program does not 
accomplish operations immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 
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Cancel the last virtual operation on the List of Pending 
Operations 

 
Cancel the last undo virtual operation on the List of Pending 
Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 

 

�  

Virtual mode is an effective way of protection from any troubles, since no operations 
will be executed until clicking the Apply button for confirmation, thus giving a second 
chance to weigh all pros and cons of this or that particular operation. The program 
politely reminds the user that there are unsaved changes by showing the following 
window: 

 

COMMON TASKS BAR  

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the 
program's wizards. 

The bar contains several tabs named Basic Partitioning Tasks, Advanced Partitioning Tasks, Basic Backup 
Tasks, Advanced Backup Tasks, Restore Tasks, Copy Tasks, Tools and News and Documentation. Each of these 
contains a separate button bar which can be folded by clicking it. 

Basic Partitioning Tasks 

 
Starting the Create Partition Wizard to create a partition of any file system. 

 
Starting the Format Partition Wizard to format an existing partition to one of 
the file systems supported by the program. 
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the file systems supported by the program. 

 
Starting the Delete Partition Wizard to delete a partition of any file system. 

Advanced Partitioning Tasks 

 
Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, 
FAT, FAT32 file systems. 

 
Starting the Redistribute Free Space Wizard to redistribute available disk 
space of existing partitions. 

 
Starting the Undelete Partitions Wizard to recover accidentally deleted 
partitions. 

 
Starting the Install New OS Wizard to install a new operating system. 

Basic Backup Tasks 

 
Starting the Sector Backup Wizard to create an archive of a hard disk or 
separate partitions. 

 
Starting the Sector Backup Wizard with the preset scheduling option. 

 
Starting the File Backup Wizard to create an archive of particular files and 
folders. 

Advanced Backup Tasks 

 
Starting the Differential Backup Wizard to create a differential to a partition 
backup. 

 
Starting the Incremental Backup Wizard to create an increment to a file or 
partition backup. 

Restore Tasks 
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Starting the Restore Wizard to restore a hard disk or partition to restore an 
entire hard disk or separate partitions from the backup image. 

 
Starting the Restore Wizard to restore files or folders from the backup image. 

 
Starting the File Transfer Wizard to retrieve data from the program’s backup 
images. 

Copy Tasks 

 
Starting the One Button Copy Wizard to clone a hard disk with one click. 

 
Starting the Copy Hard Disk Wizard to copy a hard disk. 

 
Starting the Copy Partition Wizard to copy a partition. 

Tools 

 
Starting the Manage Backup Capsule Wizard to create, resize or delete the 
backup capsule. 

 
Starting the Recovery Media Wizard to create a Linux/DOS bootable media 
which can be used to get access to your hard disk for maintenance or 
recovery purposes. 

 
Starting the Check Recovery Disk Wizard to verify recovery media for 
integrity and ability to boot from. 

 
Starting the Check Archive Integrity Wizard to verify backup archives for 
consistency. 

 
Starting the Synthetic Backup Wizard to change any property of an existing 
archive (splitting, password protection, compression level, etc.) without 
accomplishing the backup operation. 

 
Starting the File Transfer Wizard to transfer data from any media. Besides it 
provides access to Paragon backups as regular folders to browse through 
th i  t t    i d fil  
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their contents or copy required files. 

News and Documentation 

 
Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. This 
page will be displayed in the Explorer Bar. 

 
Opening a brief review on the Paragon Scripting Language. 

DISK MAP  

You can find the Disk Map in the Explorer Bar if it’s not disabled in the Partition List. It can be located either 
above the Partition List or under it, depending on the state of the Disk Map Location option (Main Menu: View 
> Disk Map Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are 
represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. 
Their color depends on the file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 

� Manufacturer, 

� Model. 

Small-sized bars display the following information about logical disks: 

� Serial number, 

� Drive letter, 

� Total size, 

� File system. 

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The 
program offers to choose from several types of the disk layout scaling. It’s done especially to increase the 
program usability. For instance, if you’ve got a high capacity hard drive containing both very large (more than 
100 GB) and rather small (less than 10 GB) partitions, you can select the logarithmic type to make all partitions 
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readable, otherwise (selecting the linear type) you won’t be able to see small partitions at all, but thing strips. 
On the other hand, if the proportional disk layout is critical for you, the linear type is exactly what you need.  

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a 
partition is too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 
automatically display detailed information on it. 

EXPLORER BAR 

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 
reference information including: 

� The help system; 

� General information on the product including its name, version and a list of helpful links; 

� Detailed information about disks selected on the Disk Map; 

� List of scheduled operations; 

� List of scripts; 

� List of archives, 

� Volume Explorer utility; 

� Disk Editor utility. 

According to these categories the Explorer Bar has several tabs: 

� Disk View, which offers the user the following options: 

- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions; 

- Disk Editor to view/edit sectors of the selected partition/hard disk; 

- Volume Explorer to browse and export contents of the selected partition/hard disk; 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form. 
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�  

You can switch between these components by clicking tabs on the left side of the 
Explorer Bar. 

� Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations and 
the program scripts. 

� Archives, which enables to manage the Archive Database. 

� Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for 
example, the company's website to look through important technical notes or download the latest updates 
without having to close the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional 
information. 

 

To easily navigate through browsed pages, the program provides the following functionality: 
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BUTTON FUNCTIONALITY 

 
Return to the previously browsed 
page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current 
page 

PARTITION LIST 

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the 
system hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list 
there is the possibility to call the context-sensitive popup menu with available operations. Besides, the program 
provides detailed information on all hard disks/partitions found in the system including the following properties: 

   - Name, 

   - Volume label (if exists), 

   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 

   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector 

   - Free size in sectors/bytes 

   - Active/Inactive attribute 

   - Hidden/Unhidden attribute 

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel. 
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By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you 
can change its order by pressing the Move up or Move down buttons. 

If you don’t need the Disk Map, please click the shown below icon to disable it: 

 

PROPERTIES BAR 

The Properties Bar provides information on the selected at the moment partition/hard disk: 

For a hard disk 

� Model, 

� Serial number, 

� Type of hard disk (basic or dynamic), 

� Total size (in GB), 

� Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

For a partition 

� Drive letter assigned to the disk, 
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� Volume label (if available), 

� Type of the logical disk, 

� File system (represented by the color of the graph and the selected bar), 

� Total size, used space and free space (in GB or MB). 

Besides you can modify practically any partition property by clicking on the required value. 

LEGEND BAR 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the 
bar with the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at 
the bottom of the Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32, 

   - NTFS, 

   - Linux Ext2/3, 

   - Linux ReiserFS. 

STATUS BAR  

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points 
to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 

SETTINGS OVERVIEW 

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several 
sections, which functions are described in the following paragraphs. The list of sections is placed on the left 
side of the dialog. By selecting a section from the list, you can open a set of options. 

�  

To get a detailed description to any setting, control, or field of the program just click 
the hint button and then the object you need. 

GENERAL OPTIONS  
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This section contains a set of general options that will be taken into account during any operation carried out 
with the program: 

� Enable data loss protection. Mark the checkbox to make the program work in the fail-safe mode (also 
referred to as the data-loss protection mode), which ensures reliability for operations by maintaining a 
special journal. In case of a hardware malfunction, power outage or an OS failure happened in the 
middle of a data-sensitive operation (resize, move, merge, redistribute, change cluster size, etc.), the 
program will ask to insert the bootable Recovery CD and automatically complete the interrupted 
operation, thus reviving the corrupted partition. 

�  
It is strongly recommended to enable this option. 

� Try to access non-BIOS disk cylinders. While working under Windows 9x you've noticed that your hard 
disk capacity is limited to 8GB, mark the checkbox to perform a special procedure of detecting its real 
capacity, but not using the value returned by the BIOS of your motherboard. 

�  
This option is only relevant for Windows 95, 98, ME. 
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� Enable Initial Backup reminders. If this option is marked, the program will automatically offer to make a 
backup before accomplishing any critical partitioning operation, thus minimizing the risk of data loss. 

BACKUP IMAGE OPTIONS  

This section contains a set of options that will be taken into account during backup/restore operations: 

� Control archive integrity. Mark the checkbox to guarantee that all backup images created with the 
program are 100 percent flawless. If you decided not to control the archive integrity, the backup 
operation would take about 3-5% less time. 

� Set image file names automatically. Mark the checkbox to make the program automatically set a file 
name for every volume of a complex backup image. Otherwise you will need to do it manually during 
the backup operation. 

� Compression level. From the pull-down list you can select the desired compression level for backup 
images that will be used by default. 

� Enable image splitting. Mark the checkbox to automatically split every backup image to volumes of a 
particular size. 
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�  

Splitting images enables to tackle problems caused by a maximum file size limitation 
of some file systems. 

� Maximum split size. With the spinner control you can specify a maximum size for backup volumes. 

PARTITIONING OPTIONS 

This section contains a set of options that will be taken into account during partitioning operations: 

� Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus 
you will be able to create FAT16 partitions up to 4GB in size 

�  

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16 
partitions larger than 2GB are not reliably accessible under these operating systems. 

� Request confirmation before partition deletion. Mark the checkbox to activate an additional security 
mechanism. Thus when going to delete a partition you will be automatically requested to enter its 
label. 
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� Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request 
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of 
conversion is the only way out to accomplish the operation. For instance, you are going to migrate 
your system to a larger hard disk with the proportional resize of existing partitions, what is very 
convenient. As a result you can get original FAT16 partitions go beyond the 4GB limit. Thus without 
conversion to FAT32, this operation will in no way be possible to accomplish. The same goes for any 
copy hard disk/partition or restore hard disk/partition operation involving an extra upsizing. 

� Surface test level. Here you can define the surface check level to make the program find bad and 
non-stable sectors before any write operation and mark them unusable in the file system metadata. 

GENERAL COPY AND BACKUP OPTIONS  

 

This section contains a set of options that will be taken into account during copy and backup operations: 

� HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, 
thus ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will 
be processed as well). This can help to avoid problems with hidden data created by certain 
applications or the system administrator. However, it will take more time to accomplish the operation. 

� Partition raw processing. Mark the checkbox to copy/back up a partition in the sector-by-sector mode 
to process unused space of that partition as well. This can help to avoid problems with hidden data 
created by certain applications or the system administrator. However, it will take more time to 
accomplish the operation. 
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� Perform incremental copy. Mark the checkbox to only copy changes on the hard disk from the 
moment of the last copy operation. The program will perform comparison between a previous copy of 
the hard disk and its current state. Only sectors that are different will be updated, thus considerably 
decreasing the amount of data to write. 

� Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus 
reducing the operation time and the resulted size of the backup image. 

�  

By clicking the link at the bottom of the window you can jump to the Copy/Backup 
Exclude Options. 

CD/DVD RECORDING OPTIONS  

 

This section contains a set of options that will be taken into account during CD/DVD burn operations: 

� Burn every CD/DVD to the end. By default, the program does not create ISO 9660 compliant burning 
sessions, as it processes data on-the-fly and can only estimate the resulted session size. That’s why no 
third party tool will get access to the recorded data. To tackle the issue, mark the checkbox to make 
the program create a standard Disk-at-Once session. It may slow down the burning process, as every 
CD/DVD will be recorded up to the end, no matter how much actual information to contain. 
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� Recording speed. The user may define how fast a CD/DVD will be recorded (minimum, normal and 
maximum). Besides there is an automatic mode when the program will set the most appropriate speed 
for every CD/DVD. 

� Bootable ISO image. That’s the image to be placed together with the backup data. By default, the 
program offers its own bootable ISO image, which contains a Linux/DOS recovery environment. 
However, the user is free to use any bootable ISO image. 

� CD/DVD boot capability. The program enables to choose whether any recorded CD/DVD will be 
bootable, or only the first one for a session, or without that function at all. 

� Folder where the ISO image is to be placed. When the user decides not to physically burn a CD/DVD, 
but create an ISO image file, this very folder will be used to contain these images. 

HOT PROCESSING OPTIONS  

 

In this section you may configure the hot processing mode: 

� Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is 
specially designed to process data without restarting your operating system. 

� Hot processing technology. From the pull-down list you can select the required hot processing 
technology. 
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� Always use hot processing. Select the option to process partitions without making them locked. Thus 
you will be able to keep working with them as usual. 

� Use hot processing only when partition is locked. Select the option to use the hot processing only when 
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, 
that once you start any operation on a partition in this mode, it will automatically be locked by the 
program, thus you won't be able to keep working with it as usual. 

� Hot processing temporary drive. Here you can select a disk drive that will be used to store the 
temporary hot backup data (by default – C:). 

�  

By clicking the link at the bottom of the window you can jump to the Run during 
Backup Options. 

RUN DURING BACKUP OPTIONS 

 

In this section you can specify external applications to execute at various phases of the backup process. It 
can be particularly useful when imaging systems with high availability requirements (MS SQL, MS Exchange, 
etc.), since it enables to create a consistent snapshot even as the data is currently modified. The point is to 
provide a coherent state of all open files and databases involved in a backup, taking into account that 
applications may still keep writing to disks. 
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Actually the backup process consists of two phases: the preparation phase (snapshot) and the data-copying 
phase. There are three points of the backup when external commands/programs can be launched: 

� Execute at the beginning of the backup process before taking a snapshot. Here you can specify an 
executable file that will help you to prepare running applications for taking a snapshot. It may contain 
specific commands/programs to delete unnecessary files, suspend services, flush transactions or 
caches, etc. Everything depends on the used applications. 

� Execute after taking a snapshot. Here you can specify an executable file that will run just after taking a 
snapshot. It may contain specific commands/programs, e.g. to resume the previously suspended 
services, etc. Everything depends on the used applications. 

� Execute after finishing the backup process. Here you can specify an executable file that will run after 
the backup process has been accomplished. It may include commands/ programs that will move the 
backup image to a particular location, etc. 

�  

By clicking the link at the bottom of the window you can jump to the Hot Processing 
Options. 

By clicking the Browse button you can get into the browser-like window to choose an executable file. 

 

The program provides the ability to work with three types of executable files (.exe, .bat, .cmd). It is up to the 
user to write batch files to safely prepare applications for backup. There are some certain general 
requirements for that: 

� All programs and commands must execute sequentially and finish before the .bat file completes its 
work. 

� It is recommended to use external commands/programs in the following format - Start/wait 
program.exe. The wait option will help to start an application and wait until it completes its work. This 
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will guarantee that all included commands/programs complete their execution before the batch file 
does. 

�  

This function is only available when the Hot Processing mode is enabled. 

The program enables to set parameters for an executable file directly from the line. 
However, if the file path contains word gaps it is necessary to enclose it in quotes in 
order to make the program distinguish between the path and the used parameters. 

By clicking the link at the bottom of the window you can jump to the Hot Processing 
Options. 

 E-MAIL OPTIONS 

 

This section contains a set of options that will be taken into account during the Send log files and Send e-mail 
notification operations: 

� Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have 
access to a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages 
are first sent to the SMTP server, which in its turn delivers them to the required recipients. The address 
may be represented as a traditional Internet host name (e.g.: mail.com) or as an IP numeric address 
(e.g. xxx.xxx.xxx.xx). 
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� User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider 
or organization's e-mail administrator. 

� My outgoing server requires authentication. Activate the option to allow the program to make 
authentication on the server before sending messages. 

- User name. Enter the name that will be used to log in to the e-mail account. 

- Password. Enter the password that will be used to access the mail server. 

� Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out operations.  

- Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain 
text. 

- Send complete report after applying operations. Activate the option to create an in-depth report on 
the carried out operations and send it after performing the last operation. 

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow the 
program to attach two pictures of the disk layout made before and after the operation is completed. 

�  

By clicking the link at the bottom of the window you can jump to the Operation 
Dependency Options. 

OPERATION DEPENDENCY OPTIONS 
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This section contains a set of options that will be taken into account when the Send e-mail notification on 
apply function is enabled. By marking/unmarking a checkbox opposite the required operation you can 
choose whether to receive an e-mail notification on its completion or not. 

�  
You won't be notified if an operation requires the system restart. 

VIRTUAL MODE OPTIONS 
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In this section you may configure the virtual mode: 

� Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection 
from any troubles, since no operation will be executed until confirmation, thus giving you a second 
chance to weigh all pros and cons of this or that particular operation. 

�  
We strongly recommend you to enable this mode. 

� Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog 
after accomplishing operations. 

FILE SYSTEM CONVERSION OPTIONS 
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This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. 
By default, the program takes locale (regional) settings from the system. Problems might occur however 
because of different standards for file names and file time stamps (Created, Modified and Last Access Time) of 
NTFS and FATxx file systems. 

To tackle problems of that kind you can manually set: 

� Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean 
Time) while FAT uses a fixed local date and time. The program takes proper account of these 
differences and enables to adjust timestamp values. 

�  
An incorrectly chosen time zone might lead to inability to launch certain software. 

� Language for file names to use during the convert operation. NTFS stores file names in Unicode while 
FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is 
required for the correct conversion of non-English file names from Unicode to ANSI and vice versa. 

�  

An incorrectly chosen codepage will certainly result in corruption of non-English file 
names. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

 

� Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to 
automatically display the local settings dialog to check and modify (if necessary) the default 
parameters before launching the convert file system operation. 

COPY/BACKUP EXCLUDE OPTIONS 

In this section the program enables to specify what data should be automatically ignored during copy and 
sector-based backup operations. You can filter certain files or folders either by the manual selection or by 
creating masks, what is more preferable. Thus you will be able to effectively manage contents of your backup 
images or partition/hard disk copies. 

By default, there are no available filters. To create a filter, please click the Add Category… button. 

 

In the opened dialog the program allows the user to define the following parameters: 
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� Name. Give to the filter any name you like, but try to use an informative one; 

� Filter. Press the Browse button to select files or folders you would like to be excluded or specify a filter 
mask by using * or ? wildcards; 

� Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox 
opposite its name you can choose whether to use it or not. 

�  

By clicking the link at the bottom of the window you can jump to the General Copy 
and Backup Options. 

WIPE OPTIONS 

 

Here you can set a specific data erasure algorithm that will be used by default during wipe operations. 

�  

The current version of the program provides support of one military standard, i.e. US 
DoD 5220.22-M. 
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GETTING INFORMATION ON DISKS AND BACKUP IMAGES  

The program provides some helpful tools to get information on the properties of disks and peculiarities of 
existing backup images. 

VIEWING DISK PROPERTIES  

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the 
actual state of the computer’s hard disks. 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. 
The small-sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar 
displays information about the disk in a bright, graphical form (available if the Properties tab is selected). 

 

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form 
of a circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the 
right you may see a table, which contains the following information: 

� Type of hard disk (basic or dynamic), 

� Total size (in GB), 

� Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be 
started. All default values for the operation parameters will correspond to the disk’s settings. The list of wizards 
contains a detailed description of tasks that can be performed by the wizard. This nullifies the possibility of 
selecting the wrong wizard. 
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When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information 
on it as well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be 
colored in accordance with the volume ratio of the used space to the free space (the light colored sector). 
The table on the right will contain the following information: 

� Volume label (if available), 

� Type of the logical disk, 

� File system (represented by the color of the graph and the selected bar), 

� Total size, used space and free space (in GB or MB). 

Below there is a list of wizards, which may be called for this disk. All default values of parameters will 
correspond to the disk settings. 

VIEWING IMAGE PROPERTIES 

General information on backup archives can be obtained either with the help of the Restore Wizard or the 
Archive Database: 

USING THE RESTORE WIZARD  

There are several ways to launch the Restore Wizard: 

� In the Main menu: select Wizards > Restore a Disk or Partition… 

� In Common Tasks bar: click the Restore a disk or partition item of the Wizards menu 

� Select a logical disk and then click the Restore the disk from an image link on the Explorer Bar page. 

At first, the wizard displays the Welcome page – simply click the Next button at the foot of the dialog window. 

The next page refers to Browse for Archive. By clicking the Switch to Archive List View link, you can see a list of 
images contained in the Archive Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. 
Archive File Details) display a short description, including: 

� Information on a type of the archive contents (whether it is sector-based or file-based), 

� Whether the archive is compressed or not, 

� Whether the archive is password protected or not, 

� The date, when the archive was created. 

In addition, there are some special graphical flags to indicate crucial properties: 

FLAG FUNCTIONALITY 

 Disk archive 

 Partition archive 

 File archive 

 MBR archive 

 System archive 

 Encrypted archive 
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 Compressed archive 

 Complex archive 

 Filtered archive 

 Differential archive 

 Incremental archive 

 File increment to a partition 
archive 

To easily manage images in the Archive Database, the program provides the following functionality: 

BUTTON FUNCTIONALITY 

 Refresh the contents of the database 

 Show only existing archives 

 Add the selected archive to the 
database 

 Delete the selected archive from the 
database 

Besides you may filter backup archives to decide whether to show only file, partition or hard disk archives. To 
do that, please select the required filter in the left top corner of the page. 

 

By clicking the Switch to File View link, you can find the required image in the browser-like window. 
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The section below (i.e. Archive File Details) displays a short description of the selected image, including: 

� Information on a type of the archive contents (whether it is sector-based or file-based), 

� Whether the archive is compressed or not, 

� Whether the archive is password protected or not, 

� The date, when the archive was created. 

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map 
network drives by clicking the appropriate buttons. 

The next page (i.e. What to restore) displays detailed information about the contents of the archive. 
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If you want to restore the image contents, click the Next button. In order to cancel, click the Cancel button. 

USING THE ARCHIVE DATABASE 

To open the Archive Database, click the appropriate tab in the Explorer Bar. The database window can be 
conditionally subdivided into several sections that differ in their purpose and functionality: 

 

1. Explorer Bar that displays properties of the selected image. 

2. Volume Explorer that enables to access the selected image as a 
regular folder to explorer its contents or to retrieve certain files. 
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3. Archive List that displays a list of images contained in the Archive 
Database (if any). Besides the program provides all the necessary 
functionality to manage backup images in the database (add, 
delete, mount, refresh, etc.) 

 

�  

All panels offer a synchronized layout and are separated by vertical and horizontal 
expandable sliders, allowing the user to customize the screen layout. 

DATA BACKUP AND RESCUE 

In this chapter you will find all the information necessary to establish a reliable data protection system. 

CREATING BACKUP IMAGES 

We have already mentioned that the most prevalent way to protect valuable data is to create backup 
copies (backup images in terms of the program) of it. Depending on a type of information you need to 
protect and the way this information should be processed, the program offers a number of handy backup 
wizards and dialogs. 

WIZARD WORK ALGORITHM 

To make your job with the program as easy and convenient as possible, all backup wizards share similar work 
algorithm. So let us just take as an example the Sector Backup Wizard to describe it in detail. 

By going through steps of the wizard, you configure all the necessary settings to launch the backup operation. 
To minimize the possibility of making any mistake, the wizard provides auxiliary information on every single 
option. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by 
clicking the hint button and then the object you need. 

STARTUP 

There are several ways to start the Sector Backup Wizard: 

Express Launcher 

� Click the Backup and Restore button and then select Backup. 

Launcher 

� In the Main Menu: select Wizards > Back up a Disk or Partition… 

� On the Common Tasks Bar: click the Back up a Disk or Partition item of the Wizards menu. 

� In the Toolbar: click the Back up a Disk or Partition button. 

SETUP 
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The wizard offers the following steps to accomplish the operation: 

� The object to back up. You can back up either an entire disk or separate partitions of the disk (primary, 
extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the 
image such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can 
be very helpful for serious disk recovery procedures. 

 

� Backup destination. The wizard allows saving backup archives to local or network drives, to physical 
partitions (without drive letters assigned), the Backup Capsule or burning them to CD/DVDs. You need 
to select a destination, taking the estimated archive size and available space on the backup 
destination into account. 

 

� Name and location of the resulted image. Provide a file name for the new image and its exact 
location. The program automatically offers an easy to understand name containing the date and the 
time of the archive creation, which can anyway be modified. 

 

�  

The program automatically calculates size of the future archive and informs the user 
about space available on the selected destination. 
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� Archive Comment. You can add some additional description to the archive that will later help to 
distinguish it from the others. 

 

In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to mark the appropriate option on the second page of the 
wizard. When it is marked, the next page enables to define: 

� Whether the archive integrity will be controlled. 

�  

Checking archive integrity enables to guarantee that all backup images created with 
the program are 100 percent flawless. Nevertheless if you decided not to control the 
archive integrity, the backup operation would take about 3-5% less time. 

� Whether image file names will be set automatically in complex archives. 

� Compression level for the backup image (including the No compression variant). 

� Whether the archive will be split (if yes, you can set the maximum size for the archive files). 

�  

Splitting images enables to tackle issues caused by a file size limitation of some file 
systems. 

� Whether the archive will be protected by password. 

� Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode 
(including unused sectors as well). 

� Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image. 

� Recording speed when the user wants to burn the backup image onto CD/DVDs. 

� ISO image folder where the archive that is to be recorded on a disc, is placed. 

� Whether the operation will be performed without rebooting the system. The program needs to reboot 
the system in order to have exclusive access to processing data. In a Windows environment this is 
difficult to achieve because even when all the other applications are closed, the system service 
programs are still running. However, there is a way to avoid rebooting. The mode of processing the 
backup operation without rebooting is named Hot Processing. You can also define specific parameters 
for the Hot Processing mode. 

RESULT 

After the backup operation is completed you receive an image of the selected disk (or the selected partition). 
This image is placed into the specified destination (a local (mounted/unmounted) or network disk, the Backup 
Capsule or a CD/DVD disc), its features defined by the wizard. 
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DIALOG WORK ALGORITHM 

All backup dialogs share similar work algorithm as well. Unlike wizards, settings of a backup dialog concentrate 
on a single page. That’s why it cannot boast high level of the self-descriptiveness. Anyway with the context 
sensitive hint system you can get an in-depth description to any setting, control, or field of the dialog just by 
clicking the hint button and then the object you need. 

�  
We recommend the program’s dialogs for experienced users mostly. 

So let us just take as an example the Partition Backup Dialog to describe its work algorithm. 

STARTUP 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Call the Partition Backup Dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Back Up Partition. 

� Call the popup menu for the selected partition (right click of the mouse button) then select the 
menu item: Back Up Partition… 

SETUP 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 
Backup button to confirm the operation. 
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� Archive Name. The program automatically offers an easy to understand name containing the date 
and the time of the archive creation, which can anyway be modified. 

� Archive Description. You can add some additional description to the archive that will later help to 
distinguish it from the others. 

� Compression Level. From the pull-down list you can select the desired compression level for the backup 
image (including the No compression variant). 

� Archive Destination. Here you can manually enter a path where to place the future backup image to 
or press the Browse button to find the required location. 

� Password Protection. By setting a password you can protect contents of the archive against 
unauthorized access.  

In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to click the More options button at the foot of the dialog 
page, so you will be able to define: 

 

� Whether the operation will be performed without rebooting the system. The program needs to reboot 
the system in order to have exclusive access to processing data. In a Windows environment this is 
difficult to achieve because even when all the other applications are closed, the system service 
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programs are still running. However, there is a way to avoid rebooting. The mode of processing the 
backup operation without rebooting is named Hot Processing. You can also define specific parameters 
for the Hot Processing mode. 

� Whether the archive will be split (if yes, you can set the maximum size for the archive files). 

�  

Splitting images enables to tackle problems caused by a maximum file size limitation 
of some file systems. 

� Whether image file names will be set automatically in complex archives. 

� Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image. 

� Whether the selected partition will be copied in the sector-to-sector mode (including unused sectors as 
well). 

� Whether backup images stored in the Archive Database will be processed during the backup 
operation. 

�  

Skipping backups of the Archive Database may considerably decrease the resulted 
image file and time to carry out the operation. 

RESULT 

After the backup operation is completed you receive an image of the selected partition. This image is placed 
into the specified destination (a local (mounted/unmounted) partition, a network disk or the Backup Capsule), 
its features defined by the dialog. 

Available operation scenarios: 

� Backing up a Hard Disk or Partition to the Backup Capsule 

� Backing up a Hard Disk or Partition to External Media (CD/DVD) 

� Backing up a Hard Disk or Partition to a Network Drive 

� Backing up a Dual Boot Mac to an External USB Drive 

� Backing up Files to a Local Mounted/Unmounted (without Drive Letter Assigned) Partition 

� Creating a Differential to a Full Partition Backup 

� Creating an Increment to a Full Partition Backup 

� Creating an Increment to a Full File Backup 

� Creating a Cyclic Partition Backup 

� Merging a Full Partition Backup with One of Its Differentials 
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RESTORING SYSTEM AND DATA 

The program includes a convenient and reliable restore wizard. With its help you can restore all types of 
backup images created with the program. It provides easy to understand instructions to configure and 
perform all the necessary settings. Moreover you can get an in-depth description to any setting, control, or 
field of the wizard just by clicking the hint button and then the object you need. 

STARTUP 

There are several ways to start the Restore Wizard: 

Express Launcher 

� Click the Backup and Restore button and then select Restore or Restore Files depending on your task. 

� Click the Rescue and Recovery button and then select Restore. 

Launcher 

� In the Main Menu: select Wizards > Restore Wizard… 

� On the Common Tasks Bar: click the Restore Wizard item of the Wizards menu. 

� In the Toolbar: click the Restore Wizard button. 

SETUP 

The wizard offers the following steps to accomplish the operation: 

� A backup image to be restored. The Browse for Archive page enables to find a backup image you 
need. 

By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will 
(i.e. Archive File Details) display a short description. 
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�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

By clicking the Switch to File View link, you can find the required image in the browser-like window. The 
section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or 
map network drives by clicking the appropriate buttons. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

File Backup Restore 

� A place to restore the archive to. From the pull-down list you can choose whether to restore contents of 
the backup image to its original location or specify some other one. 

 

Besides if you select the Original location option, you can additionally define whether to replace 
already existing files during the restore operation (good for recovering presumably corrupted files) or 
leave them intact (good for recovering accidentally deleted files). 

Sector Backup Restore 

� An item of the selected archive to be restored. The program allows you to restore not only an entire 
archive, but also separate items of the archive. It is very convenient in case of restoring separate 
partitions from the entire disk archive. 
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� A place to restore the archive to. Selecting the destination, please note - all contents on the disk 
selected for restoring purposes will be deleted during the operation. 

 

To help you get a clear-cut picture of the operation outcome, the program allows inspecting the 
resulted disk layout. 

Restoring Partition: 

� Size of the restored volume and free space before and after it on the disk. 

 

� Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be 
associated with the restored partition. 

 

Restoring Hard Disk: 

� Copy data and resize partitions proportionally. If this option is activated, the program proportionally 
changes the size of partitions keeping their relative order intact. The option can be useful when 
restoring to a larger hard disk. 

� Perform surface test. Define whether the surface test will be accomplished during the operation or not. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

 

�  

All contents on the disk selected for restoring purposes will be deleted during the 
operation. 

RESULT 

The wizard will restore the archived data, and make it available to use in the operating system. 

Available operation scenarios: 

� Restoring a Hard Disk from the Bootable Backup Capsule 

� Restoring a System Partition from External Media (CD/DVD) 

� Restoring a System Partition from a Network Drive 

� Restoring a System Partition from a Local Drive 

� Restoring Vista to a Different Hardware Configuration 

� Restoring a Dual Boot Mac from an External USB Drive 

� Restoring a File Increment 

� Restoring a File Increment to a Partition Backup 

BUILDING RECOVERY MEDIA  

The Recovery Media Builder provides the possibility to prepare the Linux/DOS recovery environment on 
external media (CD, DVD or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get 
access to your hard disk for maintenance or recovery purposes. Besides it enables to save data from partitions 
of your hard disk directly to compact discs or just burn ISO-images. 

STARTUP 

There are several ways to start the Recovery Media Builder: 

Launcher 
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� In the Main Menu: select Tools > Recovery Media Builder… 

� On the Common Tasks Bar: click the Recovery Media Builder item of the Wizards menu. 

SETUP 

The wizard offers the following steps to build recovery media: 

� Type of the recovery media. You can place it either on a CD/DVD disc, flash memory or a floppy disk. 

 

� Contents of the recovery set. You can choose whether to use the default Linux/DOS recovery 
environment (included in the installation package) or your own bootable image (need to provide a 
path to it). Besides you’re free to add any data you like to the standard image what is very convenient. 

 

� A recording device. The appropriate external media (CD/DVD, flash memory or a floppy disk) needs to 
be available in the system. 

�  

You can make an ISO image instead of burning a CD/DVD by selecting the Emulator 
drive. 

� CD/DVD writing parameters (in case you select this kind of media). Writing parameters include writing 
speed (maximum or minimum) and the ability of ejecting the recorded disc after completing the 
operation. 

 

The program supports CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also 
Blu-ray discs.  
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�  

If the inserted disc is not empty, the wizard will suggest erasing its contents (if possible). 
Once the operation has been confirmed, the program will delete the re-writable disc's 
contents and begin the recording process. 

RESULT 

As a result of the operation, you receive recovery media to use in most emergencies. 

COPY TASKS 

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition. 

CLONING HARD DISKS 

You can clone a hard disk of any file system. During the hard disk copying process, the program moves 
controlling records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this 
operation cannot be substituted by simply copying all on-disk partitions. 

The program offers two wizards that can help to clone a hard disk, i.e. the Copy Hard Disk Wizard and the One 
Button Copy Wizard. Both wizards provide nearly identical functionality, but different in the work concept. 

COPY HARD DISK WIZARD 

The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the 
necessary settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard 
provides auxiliary information on every single option. Moreover you can get an in-depth description to any 
setting, control, or field of the wizard just by clicking the hint button and then the object you need. 

�  
You need at least two hard disks to carry out this operation. 

STARTUP 

There are several ways to start the Copy Hard Disk Wizard: 

Express Launcher 

Click the Maintenance button and then select Hard Disk Migration. 

Launcher 

� In the Main Menu: select Wizards > Copy Hard Disk… 

� On the Common Tasks Bar: click the Copy Hard Disk item of the Wizards menu. 

� In the Toolbar: click the Copy Hard Disk button. 

SETUP 
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The wizard offers the following steps to accomplish the operation: 

� The hard disk to copy. Select a hard disk you want to copy. 

 

� The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to. 

 

� Copy parameters. The wizard enables to specify the following options: 

 

Copy options 

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information 
structure (e.g. unallocated space or unused sectors of existing partitions will be processed as well). This 
can help to avoid problems with hidden data created by certain applications or the system 
administrator. However, it will take more time to accomplish the operation. 

- Partition raw copy to copy a partition in the sector-by-sector mode to process unused space of that 
partition as well. This can help to avoid problems with hidden data created by certain applications or 
the system administrator. However, it will take more time to accomplish the operation. 
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- Perform incremental copy to only copy changes on the hard disk from the moment of the last copy 
operation. The program will perform comparison between a previous copy of the hard disk and its 
current state. Only sectors that are different will be updated, thus considerably decreasing the amount 
of data to write. 

Resize options 

- Remove free blocks between partitions not to keep blocks of free space between partitions on the 
targeted hard disk. 

- Copy data and resize partitions proportionally to make the program proportionally change the size of 
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to 
a larger one. 

Verification options 

This section allows you to define whether the Surface and/or the Writing verification tests will be 
accomplished during the operation. 

RESULT 

After the operation is completed, you receive a fully functional duplicate of the existing hard disk. 

Available operation scenarios: 

� System Hard Disk Migration 

ONE BUTTON COPY WIZARD 

The One Button Copy Wizard is a new approach of accomplishing such a technically complicated operation 
as cloning of a hard disk. In fact with its help you can do it just by pressing one button. 

Restrictions 

So to successfully accomplish the operation your system should meet the following requirements: 

� At least two hard disks, one of which should contain data and the other is empty 

� The destination hard disk should have enough space to take contents of at least first partition of the 
source disk 

STARTUP 

There are several ways to start the One Button Copy Wizard: 

Launcher 

� In the Main Menu: select Wizards > One Button Copy Wizard… 

� On the Common Tasks Bar: click the One Button Copy Wizard item of the Wizards menu. 

SETUP 
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If your system meets the mentioned above requirements, the wizard will automatically accomplish the copy 
operation after a ten-second pause. 

There are a number of options you can modify: 

� HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure 
(e.g. unallocated space or unused sectors of existing partitions will be processed as well). This can help 
to avoid problems with hidden data created by certain applications or the system administrator. 
However, it will take more time to accomplish the operation. 

� Partition raw copy to copy a partition in the sector-by-sector mode to process unused space of that 
partition as well. This can help to avoid problems with hidden data created by certain applications or 
the system administrator. However, it will take more time to accomplish the operation. 

� Perform incremental copy to only copy changes on the hard disk from the moment of the last copy 
operation. The program will perform comparison between a previous copy of the hard disk and its 
current state. Only sectors that are different will be updated, thus considerably decreasing the amount 
of data to write. 

� Copy without free space blocks to arrange partitions one after another. 

� Resize proportionally to proportionally change the size of partitions keeping their relative order intact. 

To do that, press the Pause button, to continue execution press Start. To interrupt the operation, press the 
Cancel button. 

RESULT 

After the operation is completed, you receive a fully functional duplicate of the existing hard disk. 
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CLONING PARTITIONS 

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning 
sample partitions. The program enables to duplicate all partition data including files, the exact structure of 
directories and file system metadata (location of files, security information, access quotas, etc.). 

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making 
any mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-
depth description to any setting, control, or field of the wizard just by clicking the hint button and then the 
object you need. 

STARTUP 

There are several ways to start the Copy Partition Wizard: 

Launcher 

� In the Main Menu: select Wizards > Copy Partition… 

� On the Common Tasks Bar: click the Copy Partition item of the Wizards menu. 

� In the Toolbar: click the Copy Partition button. 

SETUP 

The wizard offers the following steps to accomplish the operation: 

� The partition to copy. Select a partition you want to copy. 

 

� Destination disk. Select a hard disk with enough unallocated space to perform the operation. 
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�  

The program enables to copy a partition to a block of free space, which is smaller 
than the partition itself, taking into account only actual amount of data. 

� Copy parameters. The wizard enables to specify the following options: 

 

- Partition size. Define the size (in Mb) of the copied partition. 

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the 
available range of disk space. 

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of 
disk space. 

�  

Partition size and position may also be defined by using the drag-and-drop technique. 
To do that, just carry out the required operation on the Disk Map. 

RESULT 

After the operation is completed you receive a fully functional duplicate of the existing partition. 

BOOT MANAGEMENT 

Our program enables to easily manage several operating systems on one computer with the help of the Boot 
Manager Setup Wizard. Among the key features of the wizard the following should be mentioned: 

� Up to 16 operating systems on one PC; 

� Secure adding/removing of the Boot Manager startup record to/from the MBR; 

� Auto Boot option to automatically start up the previously chosen OS after a certain time period; 

� Hiding of any primary partition except selected at the moment. 

STARTUP 

Launcher 

In the Main menu: select Tools > BM Setup Wizard… 
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SETUP 

The wizard offers the following steps to accomplish the operation: 

� Hiding other primary partitions. By marking this checkbox the program will automatically assign the 
hidden flag to all primary partitions of the hard disk(s) except the one selected to boot. This will help to 
avoid any problems when dealing with different operating systems or different versions of one and the 
same OS, as they will be unaware of each other. 

 

� Boot menu options. In this section you can switch between the following modes: 

- Normal mode. Choose this mode to display the boot menu every time the computer starts up and 
define a timeout on the expiry of which the program will automatically select the previously chosen 
item of the menu. 

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this mode 
you should define a hot key used to enable the Boot Manager and a time period in seconds the 
startup message will be displayed. 

 

� Deactivating/Configuring the Boot Manager. These two options will only be available once the wizard 
has been completed and launched again. Select the Deactivate option to remove the Boot Manager 
from the MBR (Master Boot Record) or Configure to modify the previously set parameters of the startup 
process. 

 

RESULT 

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get 
control of the booting process and to be able to display the boot menu. 

Available operation scenarios: 

� Creating Dual Boot Systems 

PARTITION MANAGEMENT 
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In this chapter you will find all the information necessary to carry out partitioning operations supported by the 
program. 

BASIC PARTITIONING OPERATIONS 

Here you can learn how to accomplish basic partitioning operations (create, format, delete). 

CREATING PARTITIONS 

The program provides the ability to create a new partition by using the DOS partitioning scheme. This 
operation can be accomplished either with the Create Partition Wizard or the Create Partition Dialog. 

RESTRICTIONS 

1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program cannot create new partitions on Dynamic Disks. The current version of the program 
supports only hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are 
named Basic Disks). 

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot 
be created: 

� Two Extended Partitions on one hard disk 

� Five or more Primary partitions on one hard disk 

� If there is an Extended Partition on the disk, only three Primary partitions are allowed 

4. The program allows creating new partitions only within blocks of un-partitioned space. It cannot 
convert a free space on an existing partition to a new partition. 

WIZARD STARTUP 

There are several ways to start the Create Partition Wizard: 

Launcher 

� In the Main menu: select Wizards > Create Partition… 

� On the Common Tasks bar: click the Create Partition item of the Wizards menu. 

DIALOG STARTUP 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a block of free space on the Disk Map; 

2. Call the Create Partition Dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Create Partition. 
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� Call the popup menu for the block of free space (right click of the mouse button) then select the 
menu item: Create Partition. 

WIZARD SETUP 

The wizard offers the following steps to accomplish the operation: 

� Partition destination. Select a hard disk (if the computer has several hard disks) and then choose 
position for the future partition on the disk: at the end (preferable), at the beginning or somewhere in 
the middle between other partitions. 

 

�  

By default, the program allows you to create a new partition only as the last primary or 
as the last logical drive within the extended partition. However, by activating the 
advance mode on the first page of the wizard you can remove this restriction that in its 
turn might result in some boot problems. 

� Partition size. There is no restriction on size of the future partition, merely depending on space available 
on the hard disk. 

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all 
free space blocks together into one united block and moving partitions when necessary. If the total 
amount of free space is still not enough, it is possible to split a fragment of space from one of the 
existing partitions, thus resizing it. 
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�  

If a partition to resize is locked and cannot be processed, the wizard makes the 
system reboot to create the partition and then automatically boots the system again. 
(The rebooting mechanism is different for different versions of Windows.) 

You can also choose whether the future partition will be primary or logical by marking the appropriate 
checkbox. 

� Partition properties. On the next page of the wizard you can set a number of additional parameters: 

 

- Partition type. From the pull-down list select a file system the newly created partition will be formatted 
to, otherwise the partition will remain unformatted (so that it will not be ready to use). 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter 
usually used for drive identification. 

- Surface test level. Define the level of the surface check to make the program find bad and unstable 
sectors and mark them unusable in the file system metadata. 

DIALOG SETUP 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 
Yes button to confirm the operation. 
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� Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition 
type from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on 
the selected block of free space - within the Logical free space, only Logical partitions can be 
created; Within the Primary free space, both Primary partitions or the Extended Partition can be 
created. 

� Partition Size. Define the size (in Mb) of the new partition. 

� Free space before. Define the position (in Mb) of the new partition relative to the beginning of the 
block of free space. 

� Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition. 

�  

Partition size and position may also be defined by using the drag-and-drop technique. 
To do that, just carry out the required operation on the Disk Map. The virtual operations 
are to be available. 

� File system for new partition. From the pull-down list select a file system the newly created partition will 
be formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use). 

� Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter 
usually used for drive identification. 

� Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the 
newly formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to click the More options button at the foot of the dialog 
page. Depending on the chosen file system, the following options become available: 
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� Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 

� Whether the surface test will be performed. Define the level of the surface check to make the program 
find bad and unstable sectors and mark them unusable in the file system metadata. 

� The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. 
Set the number of sectors to be reserved for the boot area on the partition with this spinner control. 

� The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 
amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

� The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner 
control. 

�  
Number of available options depends on the selected file system type. 

RESULT 

After the operation is completed you receive a fully functional partition. 

FORMATTING PARTITIONS  

Any partition should contain some file system to be used for keeping data. The process of installing a file 
system is commonly known as formatting. A huge variety of file systems have been developed these days. 

SUPPORTED FILE SYSTEMS 

The program provides the ability to format partitions of the following file systems: 

   - FAT12 & FAT16 

   - FAT32 

   - NTFS 

   - Ext2 

   - Ext3 

   - Linux Swap v. 2 

   - HPFS 
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This operation can be accomplished either with the Format Partition Wizard or the Format Partition Dialog. 

WIZARD STARTUP 

There are several ways to start the Format Partition Wizard: 

Launcher 

� In the Main menu: select Wizards > Format Partition… 

� On the Common Tasks bar: click the Format Partition item of the Wizards menu. 

DIALOG STARTUP 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Call the Format Partition Dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Format Partition. 

� Call the popup menu for the selected partition (right click of the mouse button) then select the 
menu item: Format Partition. 

WIZARD SETUP 

The wizard offers the following steps to accomplish the operation: 

� Partition to format. Select a hard disk (if the computer has several hard disks) and then the required 
partition to format. 

 

�  
As a result of this operation contents of the selected partition will be lost. 

� Partition properties. On the next page of the wizard you can set the following partition parameters: 
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- Partition type. From the pull-down list select the desired file system type. In fact, the program displays 
only those file systems that can correctly be placed to the selected partition, taking its capacity into 
account. 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter 
usually used for drive identification. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with 
the newly formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to mark the appropriate option at the foot of the page. 
When it is marked, the next page enables to define: 

 

� Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

� Whether the surface test will be performed. Define the level of the surface check to make the program 
find bad and unstable sectors and mark them unusable in the file system metadata. 

� The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. 
Set the number of sectors to be reserved for the boot area on the partition with this spinner control. 

� The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 
amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

� The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner 
control. 

�  
Number of available options depends on the selected file system type. 

DIALOG SETUP 
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Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 
Format button to confirm the operation. 

� File system. From the pull-down list select the desired file system type. In fact, the program displays only 
those file systems that can correctly be placed to the selected partition, taking its capacity into 
account. 

� Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter 
usually used for drive identification. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to click the More options button at the foot of the dialog 
page. Depending on the chosen file system, the following options become available: 

 

� Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

� Whether the surface test will be performed. Define the level of the surface check to make the program 
find bad and unstable sectors and mark them unusable in the file system metadata. 

� The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. 
Set the number of sectors to be reserved for the boot area on the partition with this spinner control. 

� The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 
amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

� The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner 
control. 

�  
Number of available options depends on the selected file system type. 

RESULT 
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After the operation is completed you receive a fully functional partition formatted to the specified file system. 

DELETING PARTITIONS 

With the Delete Partition Wizard or the Delete Partition Dialog you can delete a partition on a hard disk 
partitioned with the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager 
included), the program can not only remove references to the deleted partition from the Partition Table, thus 
making it unavailable for the operating system, but also enables to irreversibly destroy its data. This feature will 
guarantee security of your personal information. 

WIZARD STARTUP 

There are several ways to start the Delete Partition Wizard: 

Launcher 

� In the Main menu: select Wizards > Delete Partition… 

� On the Common Tasks bar: click the Delete Partition item of the Wizards menu. 

DIALOG STARTUP 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Delete Partition. 

� Call the popup menu for the selected partition (right click of the mouse button) then select the 
menu item: Delete Partition. 

WIZARD SETUP 

The wizard offers the following steps to accomplish the operation: 

� Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required 
partition to delete. 
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�  
As a result of this operation contents of the selected partition will be lost. 

� Merge free blocks. As a result of the operation you may get several blocks of the unallocated space 
on the hard disk. So choose whether to merge them all and place at the beginning of the disk or at the 
end by selecting the required operation from the pull-down list. 

 

DIALOG SETUP 

Initially the program suggests you just to remove references to the selected partition from the Partition Table.  

 

� Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its 
Volume Label. The current volume label is displayed above. 

� Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the 
dialog. 

To additionally destroy the on-partition data, click the More options button at the foot of the dialog page, so 
you will be able to define: 
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� Select the byte mask…. The HEX value spinner control enables to set a two-figure hexadecimal 
character value ("00" by default). The available range is from "00" to "FF". It is synchronized with the 
ASCII value. 

� Specify the number of wiping passes. You can choose a number of passes for the wiping pattern. 

� Verify wipe results. You can also choose whether to carry out residual data verification or not 
specifying the percentage of sectors to check. 

RESULT 

By default, the operation takes only a fraction of a second. However, the program waits until Windows 
completes the modification of the disk layout. In case you decide to wipe the on-partition data as well, the 
operation will take much longer, depending on the set wipe parameters. 

ADVANCED PARTITIONING OPERATIONS 

Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, 
undelete, etc.). 

MERGING PARTITIONS 

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent 
partitions, into a single, larger partition. The order, in which two partitions have been chosen, is important since 
all contents of the second selected partition will be placed in a folder on the resulted joined partition. 

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions. 

STARTUP 

There are several ways to start the Merge Partitions Wizard: 

Launcher 

In the Main menu: select Wizards > Merge Partitions… 

On the Common Tasks bar: click the Merge Partitions item of the Wizards menu. 

SETUP 

The wizard offers the following steps to accomplish the operation: 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

� The partition to expand. Select a partition, the size of which you need to increase by up-taking contents 
of an adjacent partition. 

 

� The partition to merge with. Choose the second partition for the merge operation, the contents of 
which will be placed in a folder on the resulted joined partition. By default, the program offers an easy-
to-understand folder name to store files of the second partition, which however can be customized. 

 

�  

Be particularly careful when selecting system partitions to process, since the incorrect 
order, in which two partitions have been chosen, will result in inability to boot the 
operating system. 

RESULT 

After the operation is completed the disk space of the two adjacent partitions will be consolidated. 

REDISTRIBUTING UNUSED SPACE BETWEEN PARTITIONS 

The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk 
unallocated space and the unused space of other partitions. By default, the wizard adds to the target 
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partition all existing blocks of the free space. Besides you can specify partitions to act as a space donor. The 
wizard will automatically recalculate positions of the partitions and move their contents to new locations. 

STARTUP 

There are several ways to start the Redistribute Free Space Wizard: 

Launcher 

� In the Main menu: select Wizards > Redistribute Free Space… 

� On the Common Tasks bar: click the Redistribute Free Space item of the Wizards menu. 

SETUP 

The wizard offers the following steps to accomplish the operation: 

� Partition to enlarge. Select a partition, the size of which will be increased at the expense of other 
partitions. Blocks of the free space (if any) will be automatically added to the target partition. 

 

� Partition to donate. Choose any partition(s) (not only adjacent) to donate free space. 

 

� Partition size. By default, the program leaves 50% of the unused space on a partition and removes 
another 50% to add it to the target partition. However, the size to take can be customized by moving 
the slider or by manually entering the exact value. 
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RESULT 

After the operation is completed free space of the specified partition will be increased by up-taking the on-
disk unallocated space and the unused space of other partitions. 

UNDELETING PARTITIONS 

When simply deleting a partition (without additional wiping) disk management software only removes 
references to it in the Partition Table, thus leaving the possibility to recover it later. 

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as 
other partitions were not created, moved or exceeded the disk space occupied by that partition. That is why 
the program offers this function only for blocks of free space. 

The operation can be accomplished with the Undelete Partition Wizard. 

STARTUP 

There are several ways to start the Undelete Partition Wizard: 

� In the Main Menu: select Wizards > Undelete Partitions… 

� On the Common Tasks Bar: click the Undelete Partition item of the Wizards menu. 

� Select a block of free space on the Disk Map and click the Recover Lost Partitions item on the page 
that appears in the Explorer Bar. 

� Call the popup menu for the block of free space (right click of the mouse button) then select the menu 
item: Recover Lost Partitions… 

SETUP 

The wizard offers the following steps to accomplish the operation: 

� Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks. 
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� A partition to undelete (if several). By default, the program searches records of any deleted partition 
ever existed on the selected block of free space. So you can get several partitions to choose from. 

 

Most likely the required partition will be found first. If so, you may abort the search operation by pressing 
the Stop search button. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to mark the appropriate option on the second page of the 
wizard. When it is marked, the next page enables to define: 

 

� A particular file system to look for. Specify certain file system types to look for; 

� Scan all sectors. Mark the checkbox to make the wizard analyze every single sector in the specified 
search range. It may produce more accurate search results, but will require more time to accomplish 
the operation. 
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�  
To use the advance mode, a good knowledge of hard disk structure is required. 

RESULT 

After the operation is completed you receive a fully functional partition. 

INSTALLING A NEW OPERATING SYSTEM 

Getting your computer ready to install a new operating system, especially when it is going to be an additional 
OS in the system, is a rather complicated task that implies quite a number of operations, from allocating space 
to create a new partition (resize, redistribution of free space) to formatting of the newly created partition to a 
particular file system and checking its surface for bad sectors to avoid possible data loss. Operating systems 
today are being supplied with basic tools of partitioning that only enable to create a partition (in case there is 
enough unallocated space on the disk) and then format it to the specified file system type. Our program offers 
a handy Install New OS Wizard to easily carry out all the necessary operations to install a new operating 
system. 

STARTUP 

There are several ways to start the Install New OS Wizard: 

Launcher 

� In the Main menu: select Wizards > Install New OS… 

� On the Common Tasks bar: click the Install New OS item of the Wizards menu. 

SETUP 

The wizard offers the following steps to accomplish the operation: 

� Partition to install a new operating system. The program offers two ways of installing a new OS, i.e. to 
create a new primary partition for it or use an existing one. 

 

�  
Only primary partitions can be used to install an operating system. 
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- In case the first option has been marked, the wizard enables to specify: 

A hard disk (if several) where a new partition will be created. Thanks to an advanced program engine 
it is possible to use unallocated space of the disk (if any) and unused space of existing partitions to 
create a new partition; 

 

�  

To avoid any possible problems, the new partition will in no way be created as the first 
partition of the disk which already contains at least one partition. 

And its size. If there are blocks of the free space on the disk, the wizard will merge them all and 
allocate the resulted space for a new partition in the first place. If not, it will take 50% of the unused 
space of an adjacent partition. However, the size to take can be customized by moving the slider. 

 

- In case the second option has been marked, the wizard enables to choose an existing primary 
partition to install a new operating system. 
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�  

Your computer may fail if any other OS has already been installed on the selected 
partition. 

� Partition properties. 

 

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays 
only file systems that can be correctly placed to the selected partition, taking its capacity into 
account. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with 
the newly formatted partition. 

- Surface test level. Define the level of the surface check to make the program find bad and unstable 
sectors and mark them unusable in the file system metadata. 

� OS Label. Enter a label for the selected partition in the textual field. It will later be used for the drive 
identification. 

 

RESULT 

As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and 
restart the computer to launch the installation procedure. 

�  

The program will update your MBR, so most likely you won’t be able to start up any of 
the previously installed operating systems. Please launch the Boot Manager Setup 
Wizard after the installation has been completed to fix this issue. 

Available operation scenarios: 

� Creating Dual Boot Systems 

MOVING/RESIZING PARTITION 

The Move/Resize Partition function allows you to resize or change location of any partition without destroying 
its data. 

In order to move/resize a partition you should take the following steps: 
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Launcher 

1. Select a partition on the Disk Map. 

2. Call the Move/Resize Partition dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Move/Resize Partition… 

� On the Explorer bar: click on the current total size value. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 
on the Partition List, then select the menu item: Move/Resize Partition… 

3. Define parameters of the operation. 

 

� Volume size. Define size (in Mb) of the modified partition. 

� Free space before. Define the partition position (in Mb) relative to the beginning of the available 
range of disk space. 

� Free space after. Define the amount of trailing free space (in Mb) at the end of the available range 
of disk space. 

� Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to 
process its unused space as well. This can help to avoid problems with hidden data created by 
certain applications or the system administrator. However, it will take more time to accomplish the 
operation. 

�  

Partition size and position may also be defined by using the drag-and-drop technique. 
To do that, just carry out the required operation on the Disk Map. The virtual operations 
are to be available. 

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the 
partition will automatically be converted to FAT32. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

The program enables to enlarge NTFS partitions (system, locked) without rebooting 
Windows and interrupting its work, providing 100 percent guarantee that your data is 
kept intact. 

4. The operation will be performed immediately after confirmation. 

Available operation scenarios: 

� Increasing Size of a System Partition by Taking Unused Space from any Other 

� Shrinking a System Partition to Increase Size of a Data Partition 

CONVERTING FILE SYSTEM 

With our program you can change type of the used file system without destroying its data. While performing 
the operation, it first checks the current file system for consistency and then verifies whether the on-partition 
data meet the requirements of the desired file system or not. After having passed the testing, the program re-
organizes the file system metadata and user files. 

The program enables to convert the following file system types: 

- FAT16 > NTFS, FAT32 

- FAT32 > NTFS, FAT16 

- NTFS > FAT16, FAT32 

- Ext2 > Ext3 

In order to convert a file system you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map. 

2. Call the Convert File System of Partition dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Convert file system… 

� On the Explorer bar: click on the current file system type. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 
on the Partition List, then select the menu item: Convert File System… 

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just 
press the Convert button to confirm the operation. 
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� New file system. From the pull-down list choose a file system you would like to convert to. Actually 
the program only displays variants available for the operation, taking into account the current 
parameters of the selected partition and limitations of the used file system. 

� New cluster size. Define the cluster size for the partition. This parameter can have a profound effect 
on the overall performance. In a nutshell, larger clusters waste more space, but generally provide 
for slightly better performance, because of less fragmentation. So be particularly careful with it. 

�  

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please 
divide it into half. 

You may only decrease the current cluster size. 

� Surface test level. Define the level of the surface check to make the program find bad and 
unstable sectors and mark them unusable in the file system metadata. 

4. The operation will be performed immediately after confirmation. 

CHANGING CLUSTER SIZE 

Cluster size is one of the crucial parameters of any file system. Its value implicitly affects the performance of 
the files input-output activity since it defines the size of the file system metadata. Besides, the so-called waste 
space factor also depends on the cluster size. 

In order to change the cluster size of a partition you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map. 

2. Call the Change Cluster Size dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Modify > Change Cluster Size… 

� On the Explorer bar: click on the current sectors per cluster value. 

3. Define the cluster size for the partition. This parameter can have a profound effect on the overall 
performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better 
performance, because of less fragmentation. So be particularly careful with it. 
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�  

The Cluster Size value is expressed in Sectors Per Cluster. To get the Cluster Size in 
Kbytes, divide it into half. 

4. The operation will be performed immediately after confirmation. 

MAKING LOGICAL/PRIMARY 

The program allows you to include a primary partition in the extended partition, or exclude a logical partition 
from the extended partition, without partition duplication. 

In order to change a partition type you should take the following steps: 

Launcher 

1. Select a primary or logical partition on the Disk Map. 

2. Call the Make Partition Logical/Primary dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Modify > Make Partition Logical/Primary. 

� On the Explorer bar: click on the current partition type. 

 

�  

The Make Primary > Logical option is only available when the selected partition is 
adjacent to the extended partition and vice versa. 

The Make Primary > Logical option of the system partition will result in inability to boot 
the operating system. 

3. The operation will be performed immediately after confirmation. 

CHANGING PARTITION ATTRIBUTES 
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This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, Volume 
Label, etc.). 

MARK PARTITION ACTIVE/INACTIVE 

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an 
operating system will boot only if its partition is active or bootable. 

In order to mark a partition active/inactive you should take the following steps: 

1. Select a primary partition on the Disk Map. 

2. Call the Mark Partition Active/Inactive dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Mark Partition as Active/Inactive. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Mark Partition as Active/Inactive. 

 

3. The operation will be performed immediately after confirmation. 

�  

There can only be one active partition on a hard disk, otherwise your operating system 
will fail to boot. 

HIDE/UNHIDE PARTITION 

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does 
not mount hidden partitions, thus preventing access to their contents. 

In order to hide/unhide a partition you should take the following steps: 

1. Select a partition on the Disk Map.  

2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Hide/Unhide Partition. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Hide/Unhide Partition. 

3. The operation will be performed immediately after confirmation. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

�  

It is strongly recommended not to hide the system partition. Otherwise your operating 
system will fail to boot. 

SET LABEL OF A PARTITION 

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is 
detectable by any partitioning tool and is used for notification purposes only. 

In order to change a partition label you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Modify > Change Volume Label. 

� On the Explorer Bar: click on the current volume label. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Change Volume Label. 

3. Enter a label for the selected partition. 

 

4. The operation will be performed immediately after confirmation. 

CHANGE PARTITION ID 

Partition ID is a file system identifier. It is saved in the Partition Table and is used to quickly detect a partition of 
the supported type. By manually changing its value, you can manipulate accessibility of partitions. 

In order to change a partition ID you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Call the Change Partition ID dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Modify > Change Partition ID… 

� On the Explorer Bar: click on the current partition ID. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Change Partition ID… 

3. Set a new ID for the selected partition. 
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� Predefined ID. Select from the pull-down list the required ID. 

� Enter ID manually. With the spinner control set the required ID value. It has to be a 1-2 digit 
hexadecimal number. 

4. The operation will be performed immediately after confirmation. 

CHANGE SERIAL NUMBER OF A PARTITION 

FAT16, FAT32, HPFS and NTFS file systems include the Serial Number parameter. A partition's serial number is 
saved in the boot sector. Its value is generated while formatting. 

The program enables to modify the serial number parameter for FAT16, FAT32, HPFS or NTFS partitions without 
re-formatting. 

In order to change a serial number you should take the following steps: 

1. Select a partition on the Disk Map. 

2. Call the Change Partition Serial Number dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Modify > Change Serial Number. 

� On the Explorer Bar: click on the current serial number. 

3. Enter a new serial number for the selected partition. It should contain 8 hexadecimal figures (0..9 or 
A..F). The operation cannot proceed until you enter all 8 symbols. 

 

4. The operation will be performed immediately after confirmation. 

CHANGE BOOT SIZE 
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Major file systems use initial sectors of a partition to store the bootable code of an operating system. This 
partition area is generally known as the Bootable Area or the Boot Sector (actually it takes up several sectors). 

With our program you can resize the Bootable Area of a FAT-formatted partition without destroying its data. 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a FAT partition on the Disk Map. 

2. Call the Change Boot Size dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Modify > Change Boot Size… 

� On the Explorer bar: click on the current sectors per boot value. 

3. Set the number of sectors to be reserved for the boot area of the partition. 

 

4. The operation will be performed immediately after confirmation. 

CHANGE ROOT SIZE 

The maximum capacity of the Root Directory is an essential parameter for FAT12 and FAT16 file systems. The 
program enables to easily resize it.  

In order to start the operation you should take the following steps: 

Launcher 

1. Select a FAT partition on the Disk Map. 

2. Call the Change Root Size dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Modify > Change Root Size… 

� On the Explorer bar: click on the current root entries value. 

3. Set the maximum number of files/directories to place in the root directory of the partition. 
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4. The operation will be performed immediately after confirmation. 

HARD DISK MANAGEMENT 

In this chapter you will find all the information necessary to carry hard disk operations supported by the 
program (Update MBR, Convert to Basic, Change Primary Slot). 

UPDATING MBR 

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the 
standard bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a 
boot virus attack or a malfunction of boot management software. 

In order to update MBR of a hard disk you should take the following steps: 

1. Select a hard disk on the Disk Map. 

2. Call the Update MBR dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Hard Disk > Update MBR. 

� Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 
then select the menu item: Update MBR. 

 

3. The operation will be performed immediately after confirmation. 

CONVERTING TO BASIC 

The program allows you to convert a dynamic disk containing simple volumes into a basic one while keeping 
its contents intact. 

In order to convert a dynamic disk into basic you should take the following steps: 

1. Select a dynamic disk containing simple volumes on the Disk Map.  

2. Call the Convert to Basic dialog selecting in the Main Menu: Hard Disk > Convert to Basic… 
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3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a 
hard disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three 
primary partitions are allowed. That is why if a dynamic disk contains several simple volumes the 
program enables to choose the number of primary partitions. The rest of them if any will automatically 
be converted to logical disks within the Extended partition. 

 

�  

The program can only process dynamic disks containing solid simple volumes (without 
extension). 

CHANGING PRIMARY SLOT 

Different operating systems apply different approaches to enumeration of the primary partitions. 

In Linux: 

In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a 
partition itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are 
automatically generated by Linux in accordance with the order of hard disks in BIOS and the order of partition 
records in the Partition Table. Thus changing enumeration of the primary partitions can lead to changing of 
paths to some important resources. 

In DOS: 

The last versions of MS-DOS use a rather sophisticated algorithm for a drive letter assignment. A drive letter, 
which is assigned to a partition, depends on the order of records in the Partition Table. Thus changing 
enumeration of the primary partitions affects the drive letters assignment. In early versions of MS-DOS, it could 
even lead to the unavailability of a partition. 

The program provides the ability to change enumeration of the primary partitions. This feature will allow you to 
fix problems concerning an inappropriate order of partitions. 

In order to modify enumeration of the primary partitions you should take the following steps: 

1. Select a hard disk on the Disk Map. 
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2. Call the Change Primary Slot dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Hard Disk > Change Primary Slot. 

� Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, 
then select the menu item: Change Primary Slot. 

 

3. In the opened dialog you can see the current enumeration of the primary partitions of the selected 
hard disk in the Partition Table. To help you distinguish partitions from one another, the program 
provides the following parameters for every partition: 

- Slot 

- Volume 

- Partition type 

- File system 

- Partition size  

- Volume label 

There are two buttons on the right to move the selected partition up and down within the primary part 
of the Partition Table. 

4. The operation will be performed immediately after confirmation. 

WIPE TASKS 

In this chapter you will find all the information necessary to wipe a hard disk/partition of any file system or only 
destroy any remnants of deleted files/directories left on disk without affecting the used data, thus providing 
high level of security. 

The operation can be accomplished with the Wipe Wizard or corresponding dialogs. 
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WIZARD STARTUP 

Express Launcher 

� Click the Wiping button and then select Disk Wiper. 

Launcher 

� In the Main Menu: select Wizards > Wipe Hard Disk or Partition… 

WIZARD SETUP 

The wizard offers the following steps to accomplish the operation: 

� The hard disk/partition to wipe. Select a hard disk/partition the data of which you want to destroy. 

 

� Wipe mode. This section enables to switch between two options: 

 

- Wipe out all data. Select the option to irreversibly destroy all on-disk data of the selected object. 

- Clear (wipe) free space. Select the option to destroy any remnants of deleted files/directories left on 
disk without affecting the used data. 

�  

The Clear Free Space operation is available only for Logical and Primary partitions of 
known file systems. 

� Wipe method. Here you can select a specific data erasure algorithm or create a customized method 
by marking the appropriate option. 
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- In case you preferred to use a specific algorithm, the next page of the wizard enables to get detailed 
information on the selected algorithm, choose whether to carry out residual data verification or not 
specifying the percentage of sectors to check and estimate the time required to accomplish the 
operation. 

 

�  

The current version of the program provides support of one military standard, i.e. US 
DoD 5220.22-M. 

- In case you preferred to create a customized algorithm, the next page of the wizard enables to 
define up to 4 wiping patterns, number of passes for each wiping pattern and for the group of patterns. 
The Mask spinner control allows you to set a two-figure hexadecimal character value ("00" by default). 
The available range is from "00" to "FF". You can also choose whether to carry out residual data 
verification or not specifying the percentage of sectors to check. 

 

� Revise your changes. This page informs on all the actions to be made in the wizard in a bright, 
graphical form. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

 

WIZARD RESULT 

After the operation is completed you can see a well informative summary page, providing structurally divided 
in-depth information on all the actions made in the wizard. 

 

The program also enables to store the resulted report. To do that, just press the Save button and choose the 
exact location in the opened dialog. 

To make sure that all on-disk data is irreversibly destroyed call the Disk Viewer dialog by clicking the 
appropriate tab and see it for yourself. 
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�  
The Summary page will be available only when the Virtual operations are disabled. 

Available operation scenarios: 

� Hard Disk Utilization 

TASK SCHEDULING 

Automation of operations can really help you out when you’ve got to accomplish certain routine operations 
on a regular basis as it enables to execute them without your involvement while optimizing your computer’s 
work-load. 

SETTING A TIMETABLE 

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two 
categories for time settings (these correspond to appropriate items in the Schedule type menu): 

� Initiating the operation by an event: 

- One time only (i.e. the Once item) 

- When the system starts (i.e. the At System Startup item) 

- When the user logs on (i.e. the At Logon item). 

� Initiating the operation periodically (i.e. Daily, Weekly, Monthly). 
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You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables 
to set a timetable. 

 

�  

To run the task in the log-off mode, please specify administering login info by following 
the appropriate link in the left lower corner of the page. 

The Shutdown System on Complete option enables to automatically switch off the 
computer on the successful accomplishment of the operation. 

MANAGING TASKS 

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in 
the Explorer Bar: 

 

On every task you can get in-depth information, including: 

� The task name 

� The full path to the generated script of the task 

� Scheduled time of launch 
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� Statistics on the last launch 

� Scheduled time of the next launch 

� Used account information 

� Comments to the task 

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by 
clicking on the required property. 

�  

This feature can be particularly beneficial when the Scheduled Tasks list contains too 
many items. 

You can also enable/disable, rename, delete, refresh or modify properties of the selected task. 

TASK EDITOR  

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the 
following steps: 

Launcher 

1. Select a task on the Scheduled Tasks list. 

2. Call the Task Editor dialog. There are several ways to do it: 

� Click the Properties button on the Scheduled Tasks list. 

� Call the popup menu for the selected task (right click of the mouse button), then select the menu 
item: Properties. 
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3. In the opened dialog window you can see two tabs - General and Schedule. Click the General tab to 
modify: 

� Full path to the macro-command program-interpreter, which describes the scheduled task; 

� Command line for starting the interpreter (i.e. the task described in macro-language) 

� Comments referring to the task 

� The option of enabling/disabling the task. 

By clicking the Schedule tab you can modify the task timetable. 

In order to apply the changes, you need to click the Apply button at the foot of the dialog. 

CREATING A SCHEDULED TASK 

You can set a timetable for execution of any operation. For backup and copy operations the program offers 
handy wizards, while all the others can be scheduled with the Save to Scheduler dialog. 

To create a scheduled task you should take the following steps: 

Launcher 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to schedule; 

3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler…; 
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4. In the opened dialog enter the required task name and specify the task timetable; 

5. The operation will be performed immediately after confirmation. 

�  

This command is unavailable if there are no operations on the List of Pending 
Operations. 

SCRIPTING 

The program actions can also be represented in form of a script. The script describes the appropriate 
operation with macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included in the 
program installation package. This utility works in the unattended mode, which enables to automate 
operations. 

STARTUP 

You have no need to write a script since the program has a convenient interface for such a task. In order to 
generate a script on the base of the entered parameters of the required operation, you should take the 
following steps: 

Launcher 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to be scripted; 

3. Call the Generate Script dialog in the Main Menu: Tools > Generate Script…. 

SETUP 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the 
Generate button to confirm the operation. 

 

� Script file name and location. By default, the program offers to add the script to the Task List with a 
name containing its creation date and time. Unmark the Add to Task List checkbox to define an exact 
location and a filename for the script file. The default file extension that is reserved for scripting files is 
.psl, which however can be modified. 
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In addition, there is the possibility to make further detailed settings (although the default values will do in most 
cases). To activate the advance mode, you need to click the More options button at the foot of the dialog 
page, so you will be able to define: 

� Interaction with the user. Mark the option to pause the script interpreter during the execution to prompt 
the user’s confirmation or other input. Otherwise the program will not stop using default values for 
parameters if needed. 

� Commit after each operation. Mark the option to commit changes after each operation. 

� Check for errors after each operation. Mark the option to insert a special code in script, which checks 
the status of the last executed operation and stops the script processing if there are errors of any kind. 

� Discard all operations on close. Mark the option to empty the List of Pending Operations after 
generating the script. 

RESULT 

After the operation is completed you receive a new script file. It is placed into the specified destination, its 
features defined in the dialog. 

�  

This command is unavailable if there are no operations on the List of Pending 
Operations. 

To learn more about scripts please consult the Paragon Scripting Language manual. 

EXTRA FUNCTIONALITY 

This chapter describes the supplementary functionality available in the program. 

VIEW PARTITION/HARD DISK PROPERTIES 

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the 
general information, such as capacity, used space or file system type it provides the possibility to get info on 
hard disk geometry, cluster size, exact partition location, etc. 

There are several ways to get properties on a partition/hard disk: 

Launcher 
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1. Choose a partition/hard disk on the Disk Map, then select in the Main Menu: Partition/Hard Disk > 
Properties…; 

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk 
Map, then select the menu item: Properties… 

 

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get 
information you need. 

VOLUME EXPLORER 

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes 
formatted to FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon 
backups as regular folders to explorer their contents or to retrieve certain files. 

Launcher 

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume 
Explorer: 
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Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other 
location (local or network drive, etc.). 

 

Available Operation Scenarios: 

� Restoring Separate Files and Folders from a Backup 

FILE TRANSFER WIZARD 

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of 
them to CD/DVD as easy and convenient as possible. It may be of particular use in case of a system 
malfunction, caused either by a virus attack or files corruption, in order to get the system back on track again. 
Besides it provides access to Paragon backups as regular folders to browse through their contents or copy 
required files. 

STARTUP 

There are several ways to start the File Transfer Wizard: 
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Express Launcher 

� Click the Rescue and Recovery button and then select Transfer Files. 

Launcher 

� Select in the Main Menu: Tools > File Transfer Wizard. 

� Select the Restore Individual Files item of the Wizards menu on the Common Tasks Bar. 

SETUP 

The wizard offers the following steps to accomplish the transfer operation: 

� Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the 
page. The program enables to process both mounted and unmounted (without drive letter assigned) 
partitions. Besides it is possible to map a network drive. 

 

� Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by 
pressing the Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane 
and press the Remove button. You can also create a new folder, rename or irreversibly delete existing 
files/directories of the left pane by pressing the appropriate buttons. 
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�  
Files/directories deleted from the Clipboard remain intact on source disks. 

� Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, 
to physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the 
data will be stored. 

 

� Revision of changes. The Transfer Summary page provides structurally divided information on all the 
actions made in the wizard. Check the changes and come back to any step of the wizard (if 
necessary) by following the required hyperlink. 

 

RESULT  

After the operation is completed the required data will be placed into the specified destination. 

Available Operation Scenarios: 

� Copying of data from the corrupted system disk to another hard disk 

� Burning of data from the corrupted system disk to CD/DVD 

� Copying of data from a backup to the corrupted system partition 

� Restoring Separate Files and Folders from a Backup 

MOUNT PARTITION 

The program enables to assign or remove drive letters of existing formatted partitions. 

ASSIGN DRIVE LETTER 

In order to mount a partition you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map.  
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2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Assign Drive Letter… 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Assign Drive Letter… 

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for 
this parameter. So you may just press the Yes button to confirm the operation. 

 

However you can manually define the required letter by selecting it from the pull-down list of available 
drive letters.  

4. The operation will be performed immediately after confirmation. 

REMOVE DRIVE LETTER 

In order to un-mount a partition you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map.  

2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it: 

� Select in the Main Menu: Partition > Remove Drive Letter. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Remove Drive Letter. 

3. The operation will be performed immediately after confirmation. 

�  

Modifying drive letter of the system partition will result in inability to boot the operating 
system. 

After having processed partitions with installed software, some programs may not run 
properly. 

MOUNT ARCHIVE 

The program provides the ability to assign a drive letter to a partition backup image. As a result of the 
operation you will get a new read-only partition in the system to easily browse through its contents and copy 
the required information even with the standard Windows tools. 
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ASSIGN DRIVE LETTER 

In order to mount an archive you should take the following steps: 

Launcher 

1. Select a backup image in the Archive Database. 

2. Call the Mount Archive dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Archives > Mount the Selected Archive. 

� On the Explorer bar: select the Mount Archive item. 

� Call the popup menu for the selected image (right click of the mouse button), then select the 
menu item: Mount the Selected Archive… 

3. Specify a drive letter for the selected backup image. Initially the program suggests some consistent 
value for this parameter. So you may just press the Yes button to confirm the operation. 

 

However you can manually define the required letter by selecting it from the pull-down list of available 
drive letters. 

4. The operation will be performed immediately after confirmation. 

�  

The current version of the program allows the user to mount archives of separate 
partitions only. 

There is no possibility to mount archives located on physical (unmounted) partitions or 
in the bootable capsule. 

Archives will only be mounted for the current session and won’t be available after the 
system restart. 

It is strongly recommended not to un-mount backup images with Windows Disk 
Manager or other third side software. 

REMOVE DRIVE LETTER 

In order to un-mount a backup image you should take the following steps: 

Launcher 
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1. Select a backup image in the Archive Database. 

2. Call the Unmount Archive dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Archives > Unmount the Selected Archive. 

� On the Explorer bar: select the Unmount Archive item. 

� Call the popup menu for the selected image (right click of the mouse button), then select the 
menu item: Unmount the Selected Archive… 

3. The operation will be performed immediately after confirmation. 

DOWNGRADE NTFS VERSION 

With our program you can decrease version of an existing NTFS partition. This feature can be particularly useful 
when, for instance, dealing with different versions of the Windows NT family operating systems. 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map. 

2. Call the Downgrade NTFS Version dialog to set up the operation. There are several ways to do it: 

� Select in the Main menu: Partition > Modify > Downgrade NTFS Version… 

� On the Explorer bar: click on the current NTFS version. 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or 
on the Partition List, then select the menu item: Downgrade NTFS Version… 

3. Decrease version of the selected NTFS partition by selecting the one you need from the pull-down list. 

 

4. The operation will be performed immediately after confirmation. 

TEST SURFACE 

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. 
If found any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data 
loss. 

In order to start the surface test you should take the following steps: 

Launcher 
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1. Select a partition or a block of free space on the Disk Map. 

2. Call the Test Surface dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Test Surface… 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Test Surface… 

3. From the pull-down list choose the level of the surface check. 

 

4. The operation will be performed immediately after confirmation. 

CHECK FILE SYSTEM INTEGRITY 

The program allows you to check integrity of a file system. It can be used to detect possible file system errors 
before performing any operation on a partition. 

To start the system integrity check you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map 

2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it: 

� Select in the Main Menu: Partition > Check File System Integrity 

� Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, 
then select the menu item: Check File System Integrity. 

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just 
press the Yes button to confirm the operation. 
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� Automatically fix file system errors. Mark the checkbox to automatically fix any found error 
without requesting a confirmation. 

� Scan for and attempt to recover bad sectors. Mark the checkbox to additionally process sectors 
marked bad in the file system metadata for the purpose of their possible recovery. 

4. The operation will be performed immediately after confirmation. 

CHECK ARCHIVE INTEGRITY 

The program provides the ability to check integrity of a backup image. The function allows distinguishing 
between valid and corrupted images before using them. The Check Archive Integrity Wizard will help you do 
that. 

STARTUP 

There are several ways to start the Check Archive Integrity Wizard: 

Launcher 

� In the Main Menu: select Wizards > Backup Utilities > Check Archive Integrity… 

� On the Common Tasks Bar: click the Check Archive Integrity item of the Wizards menu. 

� Select a backup image in the Archive Database, then call the popup menu for it and choose the 
menu item: Check Archive Integrity… 

SETUP 

The wizard offers the following steps to accomplish the operation: 

� An archive to verify. The Browse for Archive page enables to find a backup image you need. 

By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below will 
(i.e. Archive File Details) display a short description. 
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�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

By clicking the Switch to File View link, you can find the required image in the browser-like window. The 
section below (i.e. Archive File Details) will also display a short description of the selected image. 

 

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or 
map network drives by clicking the appropriate buttons. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

RESULT 

After the operation is completed you can see results of the check. 

CHECK RECOVERY DISCS 

You’ve got the ability to check whether backup media created with the program is 100 percent error-free and 
ready to use. The Check Recovery Disc Wizard will help you do that. 

STARTUP 

There are several ways to start the Check Recovery Disc Wizard: 

Launcher 

� In the Main Menu: select Tools > Check Recovery Discs… 

� On the Common Tasks Bar: click the Check Recovery Discs item of the Wizards menu. 

SETUP 
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The wizard offers the following steps to accomplish the operation: 

� CD/DVD drive. Select from the pull-down list of available CD/DVD devices the required drive to use 
during the operation. 

 

� Set whether to eject the disk after the operation is completed or not. 

RESULT 

After the operation is completed you can see results of the check. 

EDIT/VIEW SECTORS 

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard 
disks providing the possibility to directly access and modify sectors, save and restore sectors from specified 
files, navigate through the system metadata, etc. 

In order to edit/view sectors of a hard disk/partition you should take the following steps: 

Launcher 

1. Select a hard disk/partition on the Disk Map. 

2. Call the Edit/View Sectors dialog to set up the operation. There are several ways to do it: 

� Click the Disk View tab and then choose Disk Editor. 

� Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors. 

� Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the 
Disk Map, then select the menu item: Edit/View Sectors. 
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�  
Careless use of the Edit Sectors function may result in the irreversible data corruption. 

SEND LOG FILES 

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In 
case of having difficulties with handling the program, you, with the help of this very function, can address the 
company support engineers and provide them with all the information they need such as the disk layout, 
performed operations, etc. in order to tackle the encountered problem. Information of that kind is stored in 
Log files. 

In order to send log files to the Paragon Support Team you should take the following steps: 

Launcher 

1. Call the Send Log Files dialog in the Main Menu: Tools > Send Log Files; 

2. Provide a customer name and a product serial number; 

3. Give a detailed description on the encountered problem. 
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By clicking the Send button the built-in mail client will generate a template request with attached compressed 
log files and then send it to the Paragon Support Team. 

LOG FILES 

Log files are simple textual files that can be opened by any text editor. There are several log files automatically 
generated by the program: 

Stubact.log Contains in-depth information on parameters and performance of all operations 
carried out by the program 

Pwlog.txt� Besides brief overview on operations it also contains detailed information 
about the state of all hard disks� 

Cdb.log Contains low-level information on the CD/DVD devices used in the system 

BioNTlog.txt or 
Bio95log.txt 

It is an OS-dependent supplementary log file derived from Bioxx.dll. It may 
contain valuable information on Windows family operating systems 

 

�  

Log files do not contain any confidential information on the operating system settings 
or the user documents. 

The Send Log Files function is only available when outgoing mail server (SMTP) and the 
user e-mail address are properly set. To learn more about it please consult the Settings 
Overview chapter. 

VIEW LOGS 
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With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as 
possible, all the information is structurally divided, besides there is the possibility to see the disk layout before 
and after an operation, what is very convenient.  

Launcher 

In order to view logs on carried out operations call the View Logs dialog in the Main Menu: Tools > View Logs… 

TYPICAL SCENARIOS 

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. 
You can find here useful recommendations and descriptions of operations. 

BACKUP SCENARIOS 

CREATING THE BACKUP CAPSULE 

Let us take a computer of a rank and file user who is most likely to have only one hard disk with only one 
partition (the only partition is always system). Suppose that there is enough free space on the hard disk to 
create the backup capsule as well. It can be created with the Manage Backup Capsule Wizard: 

1. Launch the Manage Backup Capsule Wizard. There are several ways to do it: 

Express Launcher 

� Click the Advanced Options button and then select Manage Backup Capsule. 

Launcher 

� In the Main Menu: select Wizards > Manage Backup Capsule 
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� On the Common Tasks bar: click the Manage Backup Capsule item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. Select a place on the disk where the backup capsule will be created. It can be created as a primary 
partition or as a logical drive within an extended partition. It can be inserted into any place on the 
hard disk: at the end (preferable), at the beginning or somewhere in the middle between other 
partitions. 

 

�  

By default, the program allows the user to create the backup capsule only as the last 
primary or as the last logical drive within the extended partition. However, by 
activating the advance mode on the first page of the wizard you can remove this 
restriction that in its turn might result in some boot problems. 

4. Set the size for the backup capsule. It will be created at the expense of free space of the selected disk. 

 

There is no restriction on the size of the backup capsule, merely depending on the available space of 
the hard disk and the capacity needed for the backup. 

If the wizard cannot find enough free space in one block, it will redistribute free space, joining all free 
space blocks together into one united block and moving partitions if necessary. If the total amount of 
free space is still not enough, it is possible to split a fragment of space from one of the existing partitions, 
thus resizing it. 

�  

If the partition is locked and cannot be resized, the wizard makes the system reboot to 
create the backup capsule and automatically boots the system again. (The rebooting 
mechanism is different for different versions of Windows). 

5. Activate the bootable recovery environment if needed. With its help you will get the choice to boot 
directly from the backup capsule for maintenance or recovery purposes every time you start up the 
computer. 
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�  

This operation will result in overwriting of the current MBR, thus in case of having a third 
side boot manager, it will be removed. To avoid that you can save the current MBR 
with the help of the Edit/View Sectors tool. 

The backup capsule can only be bootable if it is located on the bootable device 
(assigned in the BIOS). 

6. Start the operation (by clicking the Next button) or return to correct the settings. 

After the operation is completed you can place backup archives into the created backup capsule. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

BACKING UP A HARD DISK OR PARTITION TO THE BACKUP CAPSULE 

To back up an entire hard disk or a separate partition and then place the resulted image into the backup 
capsule, please do the following: 

1. Create the backup capsule with the Manage Backup Capsule Wizard. 

2. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can 
also be used here). 

3. On the Wizard's Welcome page, click the Next button. 

4. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 
partition’s name depending on the chosen task. 
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5. On the Backup Destination page, select the Save data to the Backup Capsule option. 

 

6. Edit the archive name if necessary. 

 

�  

Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, 
delete outdated backups from the Backup Capsule or resize it with the Manage 
Backup Capsule Wizard. 

7. Add comments to your backup describing its contents. 

 

8. Choose whether to accomplish the operation immediately or set a timetable for it. 
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9. On the Backup Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

�  

This operation can also be accomplished with the Linux/DOS or WinPE recovery 
environments. 

BACKING UP A HARD DISK OR PARTITION TO EXTERNAL MEDIA (CD/DVD) 

To back up an entire hard disk or a separate partition and then burn the resulted image to CD/DVD, please do 
the following: 

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can 
also be used here). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 
partition’s name depending on the chosen task. 

 

4. On the Backup Destination page, select the Burn the data to CD or DVD option. 

 

5. Select a recordable device on the list of available CD/DVD devices and edit the archive name, if 
necessary. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

 

�  

Please take into account the Estimated archive size value. It can give you a hint about 
the number of CD/DVD discs required for the operation. 

6. Add comments to your backup describing its contents. 

 

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

�  

This operation can also be accomplished with the Linux/DOS or WinPE recovery 
environments. 

BACKING UP A HARD DISK OR PARTITION TO A NETWORK DRIVE 

To back up an entire hard disk or a separate partition and then place the resulted image to a network share, 
please do the following: 

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can 
also be used here). 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a 
partition’s name depending on the chosen task. 
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4. On the Backup Destination page, select the Save data to local/network drives option. 

 

5. Map a network disk to place your backup image to: 

� Call the Map Network Drive dialog by clicking the appropriate button; 

 

� Click the standard browse button [...] to browse for the required network share or manually enter a 
path to it; 

� Define a  letter from the pull-down list of available drive letters; 

� Mark the checkbox to make this connection permanent. Otherwise it will only be available for the 
current Windows session; 

� Click the Connect as user button at the foot of the dialog page to specify a user name and 
password to access the selected network share if necessary. 

6. Edit the archive name if necessary. 
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�  

Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, 
another network drive needs to be selected. 

7. Add comments to your backup describing its contents. 

 

8. Choose whether to accomplish the operation immediately or set a timetable for it. 

 

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

�  

This operation can also be accomplished with the Linux/DOS or WinPE recovery 
environments. 

BACKING UP A DUAL BOOT MAC TO AN EXTERNAL USB DRIVE 

To back up a dual boot Mac (Mac OS X and Windows XP/Vista) and then place the resulted image to an 
external USB drive, please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Connect an external USB drive to the computer. 

3. Restart the computer. 

4. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode 
that enables to work with USB devices. 
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�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

5. In the Linux launch menu select Hard Disk Manager. 

 

6. Launch the Backup Wizard by selecting in the Main Menu of the program: Wizards > Backup Wizard. 
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7. On the Wizard's Welcome page, click the Next button. 

8. On the What to back up page, select your Mac hard disk. 

 

9. On the Backup Destination page, select the Save data to any local drive or a network share option. 

 

10. Select an external USB drive as a backup destination. 

 

11. Edit the archive name if necessary. 
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�  

Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, 
another drive needs to be selected. 

12. Add comments to your backup describing its contents. 

 

13. Choose whether to accomplish the operation immediately or generate a script. 

 

14. On the Backup Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

BACKING UP FILES TO A LOCAL MOUNTED/UNMOUNTED (WITHOUT DRIVE LETTER ASSIGNED) 
PARTITION 

To back up required files or folders and then place the resulted image to a local mounted/unmounted drive, 
please do the following: 

1. Launch the File Backup Wizard. There are several ways to do it: 

Express Launcher 

� Click the Backup and Restore button and then select Backup Files. 

Launcher 

� In the Main Menu: select Wizards > Back up Files 

� On the Common Tasks bar: click the Back up Files item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What folders and files to back up page you can see a list of all partitions (both mounted and 
unmounted) available in the system. Mark a checkbox opposite a file, folder or even a whole partition 
to build up contents of the future backup image. 
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4. On the Backup Destination page, select a local mounted/unmounted (without drive letter assigned) 
disk as a backup destination. 

 

5. Edit the archive name if necessary. 

 

6. Specify include masks. The program includes a lot of ready-made filters to effectively control contents 
of your backup images. 
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You can also create your own filter by clicking the Add category… button.  

 

� Name. Give to the filter any name you like, but try to use an informative one; 

� Filter. Press the Browse button to select files or folders you would like to be included or specify a 
filter mask by using * or ? wildcards; 

� Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox 
opposite its name you can choose whether to use it or not. 

�  

By setting an include mask, you automatically ignore files that do not match to it, thus 
they won’t be added to the backup image. 

7. Specify exclude masks. The program includes a lot of ready-made filters to effectively control contents 
of your backup images. 
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8. Add comments to your backup describing its contents. 

 

�  
This operation can also be accomplished with the WinPE recovery environment. 

CREATING A DIFFERENTIAL TO A FULL PARTITION BACKUP 

To update an image of the selected partition, please do the following: 

Launcher 

1. Click the Differential Partition Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required full (base) partition archive: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 

 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

4. The Archive Content page displays detailed information about the contents of the archive. It includes 
a full description of properties about the partition. In addition, there is the possibility to modify backup 
settings. To activate the advance mode, you need to mark the appropriate option at the foot of the 
page. 
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5. On the Backup Destination page, select where you want to place your backup image. 

 

6. Edit the archive name if necessary. 

 

�  

Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, 
another drive needs to be selected. 

7. Add comments to your backup describing its contents; 

 

8. Choose whether to accomplish the operation immediately or set a timetable for it. 
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9. On the Backup Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

After the operation is completed you receive a differential backup of the selected partition. It is placed into 
the specified destination (a local or network disk, the Backup Capsule or a CD/DVD disc), its features defined 
by the wizard. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

CREATING AN INCREMENT TO A FULL PARTITION BACKUP 

To update only files you need since the last full partition backup, please do the following: 

Launcher 

1. Click the Incremental File Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required full (base) partition archive: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 
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�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

4. On the What folders and files to back up page you can see contents of the selected partition archive. 
Mark a checkbox opposite a file or folder to build up contents of the future incremental image. 

 

5. Specify include masks. The program includes a lot of ready-made filters to effectively control contents 
of your backup images. 
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You can also create your own filter by clicking the Add category… button.  

 

� Name. Give to the filter any name you like, but try to use an informative one; 

� Filter. Press the Browse button to select files or folders you would like to be included or specify a filter 
mask by using * or ? wildcards; 

� Description. Add a short description to the filter not to miss it up later. 

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox 
opposite its name you can choose whether to use it or not. 

�  

By setting an include mask, you automatically ignore files that do not match to it, thus 
they won’t be added to the backup image. 

6. Specify exclude masks. The program includes a lot of ready-made filters to effectively control contents 
of your backup images. 
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7. Add comments to your backup describing its contents. 

 

After the operation is completed you receive an incremental backup of the selected partition archive 
containing information specified in the wizard. It is placed into the same destination as the base image. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

CREATING AN INCREMENT TO A FULL FILE BACKUP 

To update a file backup, please do the following: 

Launcher 

1. Click the Incremental File Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required full (base) file archive: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 

 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

After the operation is completed you receive an incremental backup of the selected file archive. It is placed 
into the same destination as the base image. 

�  
This operation can also be accomplished with the WinPE recovery environment. 
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CREATING A CYCLIC PARTITION BACKUP 

To automate the partition backup process, please do the following: 

Launcher 

1. Launch the Cyclic Backup Wizard by selecting in the Main Menu: Wizards > Backup Utilities > Cyclic 
Backup... 

2. On the Wizard's Welcome page, click the Next button; 

3. On the What to back up page, select a partition you want to make a cyclic backup of; 

 

�  

The current version of the program enables to make a cyclic backup of only one 
partition at a time. 

4. On the Backup Destination page, select a mounted/unmounted partition or a network share to place 
backup images to. 

 

5. Edit the archive name if necessary. 
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�  

Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, 
another drive needs to be selected. 

6. Add comments to your backup describing its contents. 

 

7. Set a timetable for the operation.  

 

�  
To know more on the subject, please consult the Task Scheduling chapter. 

8. On the Cyclic backup type page, choose the way of creating a cyclic backup: 

 

� Base type. Every image created during the operation will be made as a full archive. 

� Differential type. Every first image will be made as a full (base) archive and all the others will be 
differentiated from it. This operation requires much less space, thus considerably saving your system 
resources.  
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By setting the Maximum disk space to store images and the Maximum number of images to store 
parameters you may define when the operation will be cycled. That means that on exceeding these 
two parameters the oldest archives will be automatically overwritten (if choosing the Differential type 
only differential images will be overwritten). 

 

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

The operation will run according to the set timetable. The resulted backup images will be placed into the 
specified destination (a local or a network disk), its features defined by the wizard. 

MERGING A FULL PARTITION BACKUP WITH ONE OF ITS DIFFERENTIALS 

To merge a full partition backup with one of its differentials, thus getting a new full partition archive, please do 
the following: 

Launcher 

1. Click the Synthetic Backup item of the Wizards menu. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, you only need to specify the required differential archive. The 
program then will automatically find its base image: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 
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�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 

 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

4. On the Synthesis Settings page you can additionally modify any property of the selected backup 
image if necessary. To accomplish our task we have no need to change anything at all. 

 

5. On the Synthetic Archive Destination page, select where you want to place the resulted backup 
image. 
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6. Edit the archive name if necessary. 

 

�  

Please take into account values of the parameters Estimated archive size and Space 
available on backup destination - if the archive size exceeds the available space, 
another drive needs to be selected. 

7. Add comments to your backup describing its contents; 

 

8. On the Synthesis Summary page review all parameters of the operation and modify them if necessary. 
Click the Next button to start the backup process. 

 

After the operation is completed you receive a new full partition archive. It is placed into the specified 
destination (a local or network disk, or a CD/DVD disc), its features defined by the wizard. 

�  

This function is currently unavailable for modification of entire hard disk backups. 

This operation can also be accomplished with the WinPE recovery environment. 
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RECOVERY SCENARIOS 

RESTORING A HARD DISK FROM THE BOOTABLE BACKUP CAPSULE 

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical 
files. But you’ve got the bootable backup capsule containing a backup of your hard disk. That’s just enough 
to easily get your system back on track again. 

To restore your hard disk from a backup image contained in the backup capsule when the current OS is down, 
please do the following: 

1. Start up the computer from the bootable backup capsule. By default, the program offers to use the F1 
hot key to boot from it. 

 

�  
This scenario implies that the backup capsule is bootable. 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe 
Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

3. In the Linux launch menu select the Simple Restore Wizard. You can find the same wizard in PTS DOS as 
well. 
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4. On the Wizard's Welcome page, click the Next button. 

5. On the What to Restore page, you can see a list of available images (if several). Most likely the required 
archive will be there too. If not, click the standard browse button [...] to find it. When you find your 
image, double click on it to proceed. 

 

6. On the Image Properties page, make sure that you select the correct image by viewing the provided 
information about the archive. 

 

7. On the next page specify a hard disk to restore the image to (if several in your computer). By default, 
the program offers to restore the archive exactly where it belongs. That’s what we actually need. 
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You can also make the program resize the on-disk partitions proportionally if necessary by marking the 
appropriate checkbox. 

�  

All contents on the disk selected for restoring purposes will be deleted during the 
operation. 

8. On the Restore Summary page you can see your hard disk layout before and after the operation. Click 
the Next button to initiate the restore process. 

 

9. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 
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10. After completing the operation close the wizard and reboot the computer. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

RESTORING A SYSTEM PARTITION FROM EXTERNAL MEDIA (CD/DVD) 

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical 
files. But you’ve got a backup of your system partition on a bootable DVD disc. That’s just enough to easily get 
your system back on track again. 

To restore your system partition from a backup image located on CD/DVD when the current OS is down, 
please do the following: 

1. Insert a CD/DVD disk containing the previously prepared backup image into a CD/DVD drive (the BIOS 
must be enabled to boot the system from the CD/DVD device). 

�  

This scenario implies that you have got a bootable archive on your CD/DVD. 

In case the backup image is stored on several CD/DVD disks, please insert the first 
one. 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe 
Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover 
you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a 
serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard 
disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu. 
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�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

4. In the PTS DOS launch menu select the Simple Restore Wizard. You can find the same wizard in Linux as 
well. 

 

5. On the Wizard's Welcome page, click the Next button. 

6. On the What to Restore page, you can see a list of available images (if several). Most likely the required 
archive will be there too. If not, click the standard browse button [...] to find it. When you find your 
image, double click on it to proceed. 
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7. On the Image Properties page, make sure that you select the correct image by viewing the provided 
information about the archive. 

 

8. On the next page specify a hard disk, then one of its partitions to restore the image to (if several in your 
computer). By default, the program offers to restore the archive exactly where it belongs. That’s what 
we actually need. 

 

�  

All contents on the partition selected for restoring purposes will be deleted during the 
operation. 

9. On the Partition Start and Size page you can change size of the partition and its location if necessary. 
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10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click 
the Next button to initiate the restore process. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

12. After completing the operation close the wizard, take out the disc and then reboot the computer. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

RESTORING A SYSTEM PARTITION FROM A NETWORK DRIVE 
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Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical 
files. But you’ve got a backup of your hard disk on a remote backup server. That’s just enough to easily get 
your system back on track again. 

To restore your system partition from a backup image located on a network drive, please do the following: 

1. Insert Paragon WinPE Recovery CD (the BIOS must be enabled to boot the system from the CD/DVD 
device). 

2. Restart the computer. 

3. After the disc has been loaded, read the agreement and then mark the appropriate checkbox to 
accept. 

 

�  

If you do not agree with any conditions stated there, you won’t be able to use the 
program. 

4. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore 
Wizard. 
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5. On the Restore Wizard's Welcome page, click the Next button. 

6. On the Browse for Archive page you need to specify the required backup image. So you should take 
the following steps to do that: 

� Select Network as a backup destination; 

 

� Map a network disk where your archives are placed: 

- Call the Map Network Drive dialog by clicking the appropriate button; 
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- Click the standard browse button [...] to browse for the required network share or manually enter 
a path to it; 

- Define a letter from the pull-down list of available drive letters; 

- Click the Connect as user button at the foot of the dialog page to specify a user name and 
password to access the selected network share if necessary. 

�  
You can also map a network disk with Network Configurator. 

� Choose the required archive in the browser-like window. The Archive File Details section displays a 
short description of the selected image. 

 

7. The What to Restore page displays detailed information about the contents of the archive. Select the 
required item to restore. In our case it is the first partition of the disk. 
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8. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if 
several in your computer). By default, the program offers to restore the archive exactly where it 
belongs. That’s what we actually need. 

 

�  

All contents on the partition selected for restoring purposes will be deleted during the 
operation. 

9. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to 
change size of the partition and its location if necessary as well as assign a particular drive letter. 
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10. On the next page of the wizard confirm the operation by selecting the appropriate option. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

Mark the checkbox at the bottom of the window to automatically switch off the computer on the 
successful accomplishment of the restore operation. 

12. After completing the operation close the wizard, take out the disc and then reboot the computer. 

�  
This operation can also be accomplished with the Linux/DOS recovery environment. 

RESTORING A SYSTEM PARTITION FROM A LOCAL DRIVE 

Let’s assume that your operating system gives trouble after having installed brand new software. But you’ve 
got a backup of the system partition on a local disk. That’s just enough to easily roll it back to the point when 
run smoothly. 

To restore your system partition from a backup image located on a local disk, please do the following: 

1. Launch the Restore Wizard. There are several ways to do it: 

Express Launcher 

� Click the Backup and Restore button and then select Restore. 

� Click the Rescue and Recovery button and then select Restore. 
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Launcher 

� In the Main Menu: select Wizards > Restore a Disk or Partition 

� On the Common Tasks bar: click the Restore a Disk or Partition item of the Wizards menu. 

2. On the Restore Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required archive: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 
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�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

4. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if 
several in your computer). By default, the program offers to restore the archive exactly where it 
belongs. That’s what we actually need. 

 

�  

All contents on the partition selected for restoring purposes will be deleted during the 
operation. 

5. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to 
change size of the partition and its location if necessary as well as assign a particular drive letter. 
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6. Complete the wizard and then apply the pending changes. 

 

7. The program will require the system restart to accomplish the operation in a special boot-up mode. 
Click the appropriate button to agree. 
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8. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

After completing the operation the program will automatically reboot the computer. 

RESTORING VISTA TO A DIFFERENT HARDWARE CONFIGURATION 
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Let’s assume that the most terrible disaster has happened to your Vista-based computer – it’s broken to pieces 
because of a power outage. You’ve got a backup of your system partition on a remote backup server, but 
cannot find an exact match for your original system specifications to replace failed hardware. Well it’s too 
early to give up – our program will help you easily restore your Vista to a different hardware configuration. 

To carry out a bare metal restore from a backup image located on a network drive, please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode 
that provides a network support. 

 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

4. In the Linux launch menu select Network Configurator to establish a network connection. 

 

5. On the Wizard's Welcome page, click the Next button. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

6. On the Load Config File page, click the Next button. By default, the wizard saves all network settings in 
the netconf.ini file located on the Linux RAM drive, thus it will only be available until you restart the 
computer. However, you can just once configure your network device and then save this file to some 
other destination, for instance a local drive, and this way avoid constant re-configuration, just by 
providing a path to it. 

 

7. On the next page the wizard automatically attempts to detect all available network devices and then 
displays them (if any) in form of a list. On every found device there’s information about its interface and 
used driver as well as a brief description. You can manually add a network device in case it hasn’t 
been found automatically by clicking the Add a device button and selecting a device you need from 
the list. Do not forget to check it by clicking the Probe button. 

 

8. On the Settings for Interface page you need to properly set up the selected network device. If your 
local network has a DHCP Server, you can just leave everything as is, otherwise manually type in an IP 
address, a network mask, default gateway, etc. 
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9. On the Configure Network Connections page, click the Add button and provide all the necessary 
information to map a network share in the opened dialog. Click the Unmount button to delete an 
existing network connection if necessary. 

 

10. On the next page, save the netconf.ini file if necessary and click the Finish button to complete the 
wizard. 

11. In the Linux launch menu select the Simple Restore Wizard.  

 

12. On the Wizard's Welcome page, click the Next button. 

13. On the What to Restore page, click the standard browse button [...] to find the required archive. When 
done, double click on it to select. 
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14. On the Image Properties page, make sure that you select the correct image by viewing the provided 
information about the archive. 

 

15. On the next page specify a hard disk to restore the image to (if several in your computer). 
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Mark the checkbox at the bottom of the page to make your Vista restore to a different hardware 
configuration. Once you’ve done that, the program will display a warning message. Read it carefully 
and then click the OK button to proceed. 

 

�  

All contents on disk selected for restoring purposes will be deleted during the 
operation. 

16. On the Partition Start and Size page you can change size of the partition and its location if necessary. 

 

17. On the Restore Summary page you can see your hard disk layout before and after the operation. Click 
the Next button to initiate the restore process. 

 

18. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 
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19. After completing the operation close the wizard, take out the disc and then reboot the computer. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

RESTORING A DUAL BOOT MAC FROM AN EXTERNAL USB DRIVE 

Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your 
hard disk on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal 
restore. 

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Connect an external USB drive to the computer. 

3. Restart the computer. 

4. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode 
that enables to work with USB devices. 

 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 
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5. In the Linux launch menu select the Simple Restore Wizard. 

 

6. On the Wizard's Welcome page, click the Next button. 

7. On the What to Restore page, click the standard browse button [...] to find the required archive. When 
done, double click on it to select. 

 

8. On the Image Properties page, make sure that you select the correct image by viewing the provided 
information about the archive. 
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9. On the next page specify a hard disk to restore the image to. 

 

�  

All contents on disk selected for restoring purposes will be deleted during the 
operation. 

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click 
the Next button to initiate the restore process. 

 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 
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12. After completing the operation close the wizard, take out the disc and then reboot the computer. 

RESTORING A FILE INCREMENT 

Let’s assume that you’re busy with developing some project and you make file increments of it on a day-to-
day basis not to lose valuable information. So you’ve got a file backup chain. One day you understand that 
the job of the last three days is a complete and utter failure. Don’t give up – recover your project to the state 
when everything’s ok. 

To restore a file increment, please do the following: 

1. Launch the Restore Wizard. There are several ways to do it: 

Express Launcher 

� Click the Backup and Restore button and then select Restore Files. 

Launcher 

� In the Main Menu: select Wizards > Restore Files 

� On the Common Tasks bar: click the Restore Files item of the Wizards menu. 

2. On the Restore Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required file increment: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 
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To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 

 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 
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4. On the How to Restore page specify the way your archive will be restored. In our case we’d rather 
restore contents of the backup to its original location with replacing existing files as well. 

 

5. Complete the wizard and then apply the pending changes. 

 

6. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 
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�  
This operation can also be accomplished with the WinPE recovery environment. 

RESTORING A FILE INCREMENT TO A PARTITION BACKUP 

Let’s assume that your operating system gives trouble because of a virus attack. But you’ve got a backup of 
your system partition on a local disk. Besides you make file increments of your documents and e-mail 
database to that backup on a regular basis. That’s just enough to easily roll everything back to the point when 
run smoothly. 

To restore your system partition with a file increment from a backup image located on a local disk, please do 
the following: 

1. Launch the Restore Wizard. There are several ways to do it: 

Express Launcher 

� Click the Backup and Restore button and then select Restore Files. 

Launcher 

� In the Main Menu: select Wizards > Restore a Disk or Partition/Restore Files 

� On the Common Tasks bar: click the Restore a Disk or Partition/Restore Files item of the Wizards 
menu. 

2. On the Restore Wizard's Welcome page, click the Next button. 

3. On the Browse for Archive page, specify the required file increment archive to your system partition 
backup: 

� By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive 
Database (if any). 

 

To get a clear-cut picture on properties of the required image, just click on it and the section below 
will (i.e. Archive File Details) display a short description. 
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�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

� By clicking the Switch to File View link, you can find the required image in the browser-like window. 
The section below (i.e. Archive File Details) will also display a short description of the selected 
image. 

 

�  
To know more on the subject, please consult the Viewing Image Properties chapter. 

4. On the How to Restore File Complement page select whether you want to restore both, the partition 
archive and the desired file increment or just the file increment. In our case we choose the first option. 

 

5. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if 
several in your computer). By default, the program offers to restore the archive exactly where it 
belongs. That’s what we actually need. 
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�  

All contents on the partition selected for restoring purposes will be deleted during the 
operation. 

6. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to 
change size of the partition and its location if necessary as well as assign a particular drive letter. 

 

7. Complete the wizard and then apply the pending changes. 

 

8. The program will require the system restart to accomplish the operation in a special boot-up mode. 
Click the appropriate button to agree. 
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9. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

After completing the operation the program will automatically reboot the computer. 
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�  
This operation can also be accomplished with the WinPE recovery environment. 

COPYING OF DATA FROM THE CORRUPTED SYSTEM DISK TO ANOTHER HARD DISK 

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to 
boot, please do the following: 

1. Connect the second hard disk to the computer. 

2. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

3. Restart the computer. 

4. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe 
Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover 
you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a 
serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard 
disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu. 

 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

5. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as 
well. 
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6. On the Wizard's Welcome page, click the Next button. 

7. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

8. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 
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Click the Calc button to estimate the resulted data size. 

9. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any 
local drive or a network share item. 

 

10. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard 
browse button [...]. 

 

11. On the Transfer Summary page check all parameters of the operation. Click the Next button to 
accomplish the operation. 

12. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

13. After the operation is completed, close the wizard by pressing the appropriate button. 

14. Eject the CD. 

15. Turn off the computer. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 



 

�  
This operation can also be accomplished with the WinPE recovery environment. 

BURNING OF DATA FROM THE CORRUPTED SYSTEM DISK TO CD/DVD 

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, 
please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode 
that enables to burn CD/DVD discs. 

 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as 
well. 
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5. On the Wizard's Welcome page, click the Next button. 

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 
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Click the Calc button to estimate the resulted data size. 

8. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to 
CD/DVD item. 

 

9. On the Choose a Recorder page, select a recorder from the list of available devices and then set a 
volume label by entering it in the appropriate field. 

 

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to 
accomplish the operation. 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

12. After the operation is completed, close the wizard by pressing the appropriate button. 

13. Eject the CD. 

14. Turn off the computer. 
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�  
This operation can also be accomplished with the WinPE recovery environment. 

COPYING OF DATA FROM A BACKUP TO THE CORRUPTED SYSTEM PARTITION 

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can 
recopy these files to make the system be operable again: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe 
Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover 
you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a 
serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard 
disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu. 

 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as 
well. 
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5. On the Wizard's Welcome page, click the Next button. 

6. Select a disk where the system backup is stored from the pull-down list in the right pane of the page. 

 

7. Double click on the required backup to open. 

 

8. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 
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Click the Calc button to estimate the resulted data size. 

9. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any 
local drive or a network share item. 

 

10. On the Select Destination Path page, select your system disk to copy the data to by pressing the 
standard browse button [...]. 

 

11. On the Transfer Summary page check all parameters of the operation. Click the Next button to 
accomplish the operation. 
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12. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

13. After the operation is completed, close the wizard by pressing the appropriate button. 

14. Eject the CD. 

15. Turn off the computer. 

�  
This operation can also be accomplished with the WinPE recovery environment. 

RESTORING SEPARATE FILES AND FOLDERS FROM A BACKUP 

The program provides a very convenient option to access backup archives and restore only data you need. 
This operation can be accomplished either with the File Transfer Wizard or Volume Explorer. 

FILE TRANSFER WIZARD 

To restore separate files and folders from a backup image with the File Transfer Wizard, please do the 
following: 

1. Launch the File Transfer Wizard. There are several ways to do it: 

Express Launcher 

� Click the Rescue and Recovery button and then select Transfer Files. 

Launcher 

� Select in the Main Menu: Tools > File Transfer Wizard 

� Select the Restore Individual Files item of the Wizards menu on the Common Tasks Bar. 

2. On the Wizard's Welcome page, click the Next button. 

3. Select a disk where the required backup is stored from the pull-down list in the right pane of the page. 
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4. Double click on the required backup to open. 

 

5. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

6. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any 
local drive or a network share item. 

 

7. On the Select Destination Path page, specify the exact place to copy the data to. 
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8. On the Transfer Summary page check all parameters of the operation. Click the Next button to 
accomplish the operation. 

 

9. After the operation is completed, close the wizard by pressing the appropriate button. 

VOLUME EXPLORER 

To restore separate files and folders from a backup image with Volume Explorer, please do the following: 

Launcher 

1. Click the Disk View tab and then choose Volume Explorer; 

 

2. Browse for the required archive and then open it by double click of the left mouse button. 
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3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the 
Export item. 

 

4. Select a place on the disk where the file/folder will be extracted to. 

 

5. Click the OK button to accomplish the operation. 

�  

The current version of the program does not enable to access file archives with 
Volume Explorer. 
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RESIZE SCENARIOS 

INCREASING SIZE OF A SYSTEM PARTITION BY TAKING UNUSED SPACE FROM ANY OTHER 

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming 
applications and system updates your system partition has started to suffer from the lack of free space. But 
one of your partitions has a plenty of redundant space. That’s just enough to make your system partition suffer 
no more. 

To increase size of a system partition by taking unused space from any other on-disk partition, please do the 
following: 

1. Click the Advanced Options button and then select HDM 2009 Server in the Express Launcher. 

 

2. In the main window of HDM select the required hard disk (if several) on the Disk Map. 

 

3. Choose a space donor partition and then call the context menu for it (right click of the mouse button) 
to launch the Move/Resize dialog. 
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4. In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While 
doing this, free space from the partition will be released (displayed in aqua-green). You can also do it 
manually by entering the exact size of free space. Click the Yes button to continue. 

 

5. Now you’ve got a block of free space to add to the system partition. You cannot do it directly 
however, but by carrying out a number of extra move/resize operations. 

 

6. Since the block of free space is within the extended partition, you need to take it out first. The program 
enables to resize the extended partition only when there’s a block of free space adjoining its borders. 
In our case it’s between two logical disks. So we need to move it. To do that, please select the first 
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logical partition and then call the context menu for it (right click of the mouse button) to launch the 
Move/Resize dialog. 

 

7. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure 
the partition size has been left unchanged. 

 

8. Now you can resize the extended partition to take the block of free space out of it. Call the context 
menu for it (right click of the mouse button) to launch the Move/Resize dialog. 

9. In the opened dialog shift the edge of the extended partition to the right. 
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10. The block of free space has been released. 

 

11. Now you need to move the second primary partition just the way we did it with the logical partition to 
make the block of free space adjoin the system partition. 

 

12. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) 
to launch the Move/Resize dialog. 

13. In the opened dialog shift the edge of the partition to the right, thus increasing its size. 

 

14. Apply all introduced changes. By default, HDM works in the virtual mode of execution, so you have to 
confirm all operations to let the program accomplish them. To do that, just click the Apply button on 
the Virtual Operations Bar. 
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15. The program will require the system restart to accomplish the operation in a special boot-up mode. 
Click the appropriate button to agree. 

SHRINKING A SYSTEM PARTITION TO INCREASE SIZE OF A DATA PARTITION 

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and 
is exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your 
system partition doesn’t need so much disk space, that’s what your data partition really requires at the 
moment. You can easily tackle this problem with Paragon Linux/DOS Recovery CD. 

To increase size of a data partition by taking unused space from a system partition, please do the following: 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Restart the computer. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe 
Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover 
you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a 
serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard 
disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu. 

 

�  

By default the Normal Mode will be automatically initiated after a 10 second idle 
period. 

4. In the Linux launch menu select Hard Disk Manager. You can find it in PTS DOS as well. 
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5. In the main window of HDM select the required hard disk (if several) on the Disk Map. 

 

6. Choose your system partition and then call the context menu for it (right click of the mouse button) to 
launch the Move/Resize dialog. 
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7. In the opened dialog set a new size for the partition by moving the slider or by entering the exact value 
in the appropriate field. While doing this, free space from the partition will be released (displayed in 
aqua-green). Click OK to continue. 

 

8. Now you’ve got a block of free space to add to your data partition. 

 

9. Choose the data partition and then call the context menu for it (right click of the mouse button) to 
launch the Move/Resize dialog. 

10. Move the slider to the right to increase size of the partition. Click OK to continue. 

 

11. Apply the pending changes. 
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12. In the Progress window you can see in real-time a detailed report on all actions carried out by the 
program. 

 

CREATING DUAL BOOT SYSTEMS 

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this 
connection we decided to consider two the most frequently used situations a rank and file user may face, i.e. 
Windows Vista + Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security 
and system independence these operating systems will be installed on different partitions. That is why we need 
to hide the first system partition before installation of the second OS. 

WINDOWS VISTA + WINDOWS XP 

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one 
thing – your favourite applications simply reject to work correctly on it. Software updates are expected to 
release in the near future, but you cannot wait any more. Thus the best way out is to leave Windows Vista 
intact and install the time-proved Windows XP. 

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the 
second operating system you need to repartition your drive first, as it requires a separate primary partition. If 
this is the case, you can do your job either with the Install New OS Wizard (a specially designed tool for that) or 
traditionally with a number of the corresponding wizards and dialogs. 

INSTALL NEW OS WIZARD 

�  

This scenario implies that operating systems will be installed on different partitions to 
provide better security and system independence. 

1. Click the Advanced Options button and then select HDM 2009 Server in the Express Launcher. 
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2. In the main window of HDM select Install New OS of the Wizards menu. 

 

3. On the Wizard's Welcome page, click the Next button. 

4. Select the appropriate option to create a new primary partition on your hard disk. 

 

5. On the next page of the wizard, define size of the new partition. If the selected hard disk contains 
blocks of free space, the wizard will automatically merge them all and allocate the resulted space to 
create the partition. If not, it will take 50% of the unused space of an adjacent partition, thus resizing it. 
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6. The next page enables to specify a file system and a number of additional parameters. Since we are 
going to install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to 
continue. 

 

�  

On this page you can specify a number of additional parameters that can also be of 
help. However here we pay attention to the most relevant to fulfill our task. 

7. Enter a label for the future partition in the textual field. It will later be used for the drive identification. 

 

8. Complete the wizard and then apply the pending changes. By default, HDM works in the virtual mode 
of execution, so you have to confirm all operations to let the program accomplish them. To do that, 
just click the Apply button on the Virtual Operations Bar. 
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9. The program will carry out all the necessary operations and then automatically restart the computer to 
initiate the installation process. 

�  

If you’ve changed your mind on installing a new operating system, don’t insert its 
distributive CD but press ESC when the following message  appears: 

 

All the mentioned above operations can also be accomplished with the WinPE 
Recovery CD. 

10. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you 
can find all the necessary information in documentation that comes with the product. However to 
avoid any problems, we consider it necessary to draw your attention on the following issues: 

- You need a bootable distributive CD of Windows XP to install it; 

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from 
CD first or press F12 during startup to select a bootable device; 

- Do not forget to select the newly created partition as destination. 

 

11. So if everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your 
Windows Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager 
Setup wizard. To do that, please install Hard Disk Manager 2009 Server once again, but this time in 
Windows XP to activate Boot Manager. 

�  

To avoid double installation of HDM 2009 Server, you can use the WinPE Recovery CD 
to activate Boot Manager. 

12. Click the Advanced Options button and then select HDM 2009 Server in the Express Launcher. 
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13. In the main window of HDM select: Tools > BM Setup Wizard… 

 

14. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary 
partitions except the one selected to boot and it is by all means should be activated to make Windows 
Vista and Windows XP unaware of each other. The rest of the parameters offered by default will do in 
our case, so just complete the wizard and it will automatically find the two operating systems and 
update the MBR. 

 

15. Now restart the computer to make sure you have got a dual boot system. 
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TRADITIONAL WAY 

�  

This scenario implies that operating systems will be installed on different partitions to 
provide better security and system independence. 

1. Click the Advanced Options button and then select HDM 2009 Server in the Express Launcher. 

 

2. In the main window of HDM select your hard disk on the Disk Map to make a block of free space on it. 

 

3. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, 
please call the context menu for the selected partition (right click of the mouse button) and launch the 
Move/Resize dialog. 
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4. In the opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While 
doing this, free space from the partition will be released (displayed in aqua-green). You can also do it 
manually by entering the exact size of free space. Click the Yes button to continue. 

 

�  

The Move/Resize dialog offers a number of additional parameters that can also be of 
help. However here we pay attention to the most relevant to fulfill our task. 

5. Now you have a block of free space sufficient in size to hold a new partition. 

 

6. Create a new partition to install Windows XP. To do that, please call the context menu for a newly 
created block of free space (right click of the mouse button) and launch the Create Partition dialog. 
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7. Define parameters of the future partition. By all means it has to be primary and since we are going to 
install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to 
continue. 

 

�  

The Create Partition dialog offers a number of additional parameters that can also be 
of help. However here we pay attention to the most relevant to fulfill our task. 

8. As a result of the operation we have got a newly created FAT32 partition just enough in size to 
comfortably work with Windows XP. 

 

9. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it 
is the best way to provide system independence. To do that, please call the context menu for it (right 
click of the mouse button) and launch the Hide Partition dialog. Click the Yes button to continue. 
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�  
Hiding of the system partition will make OS non-bootable, what is quite normal. 

10. Apply all introduced changes. By default, HDM works in the virtual mode of execution, so you have to 
confirm all operations to let the program accomplish them. To do that, just click the Apply button on 
the Virtual Operations Bar. 

 

11. The program will require the system restart to accomplish the operation in a special boot-up mode. 
Click the appropriate button to agree. 

�  

After all the operations are completed you will not be able to restart the system, what 
is quite normal. Nevertheless if you do try it, the following error will occur: 

 

All the mentioned above operations can also be accomplished with the WinPE 
Recovery CD. 

12. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you 
can find all the necessary information in documentation that comes with the product. However to 
avoid any problems, we consider it necessary to draw your attention on the following issues: 

- You need a bootable distributive CD of Windows XP to install it; 
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- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from 
CD first or press F12 during startup to select a bootable device; 

- Do not forget to select the newly created partition as destination. 

 

�  
Installation of Windows XP will make Windows Vista non-bootable. 

13. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to 
install Hard Disk Manager 2009 Server once again, but this time in Windows XP to activate Boot 
Manager. 

�  

To avoid double installation of the HDM 2009 Server, you can use the WinPE Recovery 
CD to activate Boot Manager. 

14. Click the Advanced Options button and then select HDM 2009 Server in the Express Launcher. 

 

15. In the main window of HDM select: Tools > BM Setup Wizard… 
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16. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary 
partitions except the one selected to boot and it is by all means should be activated to make Windows 
Vista and Windows XP unaware of each other. The rest of the parameters offered by default will do in 
our case, so just complete the wizard and it will automatically find the two operating systems and 
update the MBR. 

 

17. Now restart the computer to make sure you have got a dual boot system. 

WINDOWS XP + WINDOWS VISTA 

If you’ve got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications 
will flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows 
Vista for studying purposes. 

As this very situation is very close to the previous one, please use the Windows Vista + Windows XP scenario. 
However please take into consideration one more step you need to accomplish if you decide to use the 
traditional scenario: 

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive 
as well. To do that, please call the context menu for it (right click of the mouse button) and launch the 
corresponding dialog. Click the Yes button to continue; 
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REVIVING THE SYSTEM PARTITION 

In case you are not able or not willing to complete the mentioned above scenarios, but have already 
reached the point when all changes are applied and everything is ready to install the second OS, please do 
the following to make your system bootable once again (only relevant for the traditional scenario): 

1. Insert Paragon Linux/DOS Recovery CD (the BIOS must be enabled to boot the system from the 
CD/DVD device). 

2. Restart the computer. 

3. Select the Paragon Hard Disk Manager item of the main menu. 

 

4. In the main window of HDM select your non-bootable Windows partition on the Disk Map. 
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5. Unhide the partition by calling the context menu for it (right click of the mouse button) and then 
selecting Unhide. 

 

6. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well 
by calling the context menu for it (right click of the mouse button) and then selecting Set Active. 

 

7. You will be notified after the operations are completed. 
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8. Restart the computer. 

SYSTEM HARD DISK MIGRATION 

To migrate your system hard disk to a larger disk, please do the following: 

1. Connect both source and destination disks to the computer. 

2. Turn on the computer. 

3. Launch the Hard Disk Copy Wizard. There are several ways to do it: 

Express Launcher 

� Click the Maintenance button and then select Hard Disk Migration. 

Launcher 

� In the Main Menu: select Wizards > Copy Disk 

� On the Common Tasks bar: click the Copy Disk item of the Wizards menu. 

4. On the Wizard's Welcome page, click the Next button. 

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy). 

 

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the 
source disk). 
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�  
During the operation all contents of the destination disk will be deleted. 

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data with a 
proportional resize to occupy the entire disk. Besides we recommend you to enable the surface test to 
make sure your new hard disk is flawless. 

 

8. On the Revise Copy Results page review all parameters of the operation. 

 

9. Complete the wizard and then apply the pending changes. 
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10. When copying is completed, shut down the computer. 

11. Disconnect (physically) the source hard disk. 

12. Boot the computer from the destination hard disk. 

HARD DISK OPTIMIZATION 

To defragment an NTFS or FAT partition, please do the following: 

�  

You must have administrator’s privileges to accomplish defragmentation of the system 
partition. 

1. Start Paragon Total Defrag by clicking the Maintenance button of the Express Launcher and then 
selecting Hard Disk Optimization. 

 

2. In the main window, select a partition you want to defragment on the Disk Map. 
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3. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right 
click of the mouse button) and then selecting the menu item: Defragment Partition… 

 

4. In the opened dialog define settings of the operation. To improve the performance we recommend 
you to mark the Do not save content of the Pagefile.sys or (and) Hiberfile.sys checkbox as these files 
are only needed for the current Windows session. 

 

�  

The Defragment Partition dialog offers a number of additional parameters that can also 
be of help. However here we pay attention to the most relevant to fulfill our task. 

5. Start the operation by clicking the Yes button. 
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HARD DISK UTILIZATION 

To irreversibly destroy all on-disk information without any possibility to recover and that way providing the 
maximum level of security, please do the following: 

Launch the Wipe Wizard. There are several ways to do it: 

Express Launcher 

� Click the Wiping button and then select Disk Wiper. 

Launcher 

� In the Main Menu: select Wizards > Wipe Hard Disk or Partition… 

� On the Wizard's Welcome page, click the Next button. 

1. Select a hard disk, the data of which you want to wipe out. 

 

2. On the Wipe Mode page, select the wipe out all the data to irreversible destroy all on-disk information. 

 

3. On the Wipe Method page select a specific data erasure algorithm or choose to create a customized 
one (in our case we prefer to use a certified military standard). 

 

4. The next page of the wizard enables to get detailed information on the selected algorithm, choose 
whether to carry out residual data verification or not specifying the percentage of sectors to check 
and estimate the time required to accomplish the operation. 
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5. Review all parameters of the operation and modify them if necessary. 

 

6. Complete the wizard and then apply the pending changes. 

TROUBLESHOOTER 

Here you can find answers to the most frequently asked questions that might arise while using the program. 

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the 
computer. 

There are a number of operations that cannot be performed while your partition is in use (or locked in 
other words). Please agree to reboot your machine to make the program accomplish the operation in 
a special boot-up mode. 

2. I run an operation and restart the machine as required, but it just boots back into Windows without 
accomplishing the operation. 

Please run 'chkdsk /f' for the partition in question. 

3. I cannot create a new partition on the disk. 

There can be a number of reasons for that: 

� The program cannot create a new partition on a dynamic disk, but only on a hard disk that uses 
the DOS partitioning scheme. 
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� According to the rules of the DOS partitioning scheme, the following combinations of partitions 
cannot be created: 

- Two Extended Partitions on one hard disk; 

- Five or more Primary partitions on one hard disk; 

- If there is an Extended Partition on the disk, only three Primary partitions are allowed. 

� The program allows creating new partitions only within blocks of un-partitioned space. It cannot 
convert a free space on an existing partition to a new partition. 

4. I cannot copy a partition. 

There can be a number of reasons for that: 

- The source or target disk you select is a dynamic disk; 

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk. 

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed 
circle sign no matter which partition is selected. 

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a 
block of free space on your hard disk, please delete or reduce an existing partition to accomplish the 
operation. 

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area 
on it. 

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix 
the issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc 
to write a standard code to your flash drive. 

7. When trying to back up my system the program asks to restart the computer. 

Most likely the Hot Processing mode is disabled. Please make it active in the program settings. 

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws 
"VSS could not be started for processed volume". 

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon 
Hot Processing mode instead. 

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with 
the following error: Hard Disk management, Error Code 0x1100a. What is wrong here? 

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. 
But this service has not been started in your WindowsXP/Windows2003/Vista. Please start this service 
(right click on My Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and 
make it active. Set also to start it automatically). 

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error 
code 0x1200e "Internal error during Hot Backup" 
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Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error 
code 0x12016 "VSS: can't read volume data” 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't open/create 
file" 

Please check whether you’ve got a permission to write to the selected destination or not. 

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or 
"Archive does not fit" 

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa. 

14. I set up a timetable for a task, but it fails to execute. 

There can be a number of reasons for that: 

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple 
task (call Notepad through scheduling); 

- You don’t have permission to write to the selected backup destination. 

GLOSSARY  

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a 
primary partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the 
system volume.  

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard 
bootstrap. 

The term backup originates from the time when the best way to protect valuable information was to store it in 
form of archives on external media. It’s become now a general notion to mean making duplications of data 
for protection purposes. 

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. 
Thus you will be able to restore the data from these archives without having to run the program, but by simply 
booting from these CD/DVDs. 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by 
Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller 
the cluster size, the more efficiently a disk stores information. If no cluster size is specified during formatting, 
Windows picks defaults based on the size of the volume. These defaults are selected to reduce the amount of 
space that is lost and the amount of fragmentation on the volume. A cluster is also called an allocation unit. 
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Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended 
partition is used if you want to create more than four volumes on a disk, since it may contain multiple logical 
drives. 

File System Metadata. The servicing structures of a file system, which contain information about allocating files 
and directories, security information etc, are named the file system metadata. It is invisible for users and 
regular applications because its accidental modification usually makes a partition unusable. 

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders 
are divided into tracks (or heads), and tracks are divided into sectors. 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard 
Disk Geometry or C/H/S geometry. 

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters 
play an essential role in the DOS Partitioning scheme. 

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-
disk sectors are continuously enumerated from “0”. To allow backward compatibility with older standards, 
modern hard disks can additionally emulate the C/H/S geometry. 

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By 
default, an operating system does not mount a hidden partition, thus preventing access to its contents. 

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is 
achieved by XOR-ing the partition ID with a 0x10 hexadecimal value. 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file 
attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to 
a FAT table in a FAT file system. 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains important 
information about the disk layout: 

- The used partitioning scheme; 

- The starting records of the Partition Table; 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.  

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is 
allowed to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and 
Paragon Boot Manager are located in the 0th track. 

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect 
partitions of supported types. A number of operating systems completely rely on it to distinguish supported 
partitions. 

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space. 

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's 
boot sector. This value is used for notification purposes only. It is detectable by any partitioning tool including 
the DOS FDISK utility. 
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Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a 
relatively large amount of text in multiple languages. 

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on 
partitions located on a hard disk. 

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning 
scheme. It was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC 
compatible computers. 

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX 
mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 
operating system. 

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and 
the new Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support 
DDM. In addition, most hard disk utilities do not support it as well. 

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for 
maintenance or recovery purposes. 

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In 
modern file systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case 
for old FAT12 and FAT16 file systems. 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number 
represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR 
sector is initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the 
FDISK utility. 

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that 
Windows NT, 2000 and XP store its value in the database of assigned drive letters. 

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned 
when the partition is formatted. It does not play an important role for most operating systems and software as 
well. 

Copyright© 1994-2008 Paragon Software Group. All rights reserved. 
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